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Introduction
Features
packVol is a powerful load planning software. The application has no limits on
the number of containers, or on the total number of diﬀerent package items, or on
the total number of packages it can handle, which are limited only by the available
memory. The program is extremely fast and can optimize space utilization for load
plans with thousands of packages in fractions of a second on a common personal
computer.
packVol has the unique feature to let you work in two distinct modes, automatic
and manual:
• In automatic mode the load plan is evaluated by the internal optimizer
of the program;
• In manual mode the load plan is defined by the User, thanks to a 3D
graphical environment having the most common editing functions: select,
copy, paste, cut, undo, redo, zoom, pane, etc..
To simplify data entry operations packVol has,
• an internal database where you can store container and package data;
• filters to import from Excel file or from ODBC data sources.
packVol oﬀers many functions for saving data, creating reports and exporting data.

System requirements
c The program has been tested on Windows XP SP3, Windows
MS Windows ⃝:
Vista, Windows 7, Windows 8/8.1, Windows 10, Windows Server 2003, Windows
Server 2008, Windows Server 2012, Windows Server 2016. Minimum requirements:

• 233 MHz processor or higher;
• 64 MB RAM memory;
• Video card with 16 bit color depth or higher. A screen resolution of
1024x768 or higher is recommended. Resolutions lower than 1024x768
are not supported;
• 3D graphics acceleration is not required but highly recommended if you
want to use the manual mode;
• 22 MB of free space on hard disk.
c 2003-2020 Antimo Angelucci - packVol.com
⃝

To my wife and my daughter,
for their infinite patience
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Installation
c a setup program will install the application and configure your
MS Windows ⃝:
system. You can easily uninstall the program by invoking the “Windows Control
Panel”, by double-clicking on “Add/Remove Programs”, and then by choosing the
“packVol” item.
The non registered evaluation version is fully functional for 30 days after the first
installation.

Getting Started
After opening the program, select
first the tool
“Containers” and
then the Current tab. Enter the inner
dimensions of the container. Check
that the choice Closed cnt in the Fill:
combo box stays selected. Leave all
other options as suggested by the
program. In a second time you can
try to change these values to check
how the parameters alter the solution.
Then press the tool
“Packages”
and select the Dimensions tab. For
each package item input the number
of packages (qty) and the dimensions
l,w,h. The field code is descriptive and
can be left blank. The field pk, readonly, shows the number of packages
loaded in the solution.

From the panel “Solver - Messages”
select the tab Automatic and press the
Tools → Start Evaluation item in the
menu bar or press the corresponding
command
in the toolbar. The command starts the optimization run, which is
performed for a predefined time of 9 s (you can easily change the value). To save the
result on a file (with extension .3dp), go to File → Save

. Any saved document

can be re-opened with the menu command File → Open
.
The sub folder Examples of the installation folder contains some example of optimization runs.
All input fields or grid cells are integer valued, except those that refer to weights.
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User Interface
The working area of the application, besides the standard menu bar, tool bar, and
status bar, is divided in five parts:

A) the Visualization Area, on the right;
B) the Solver Panel and Messages Panel, up - left;
C) the Package and Container Panels, down - left;
D) the Report Text Controls, below the former;
E) the Auxiliary Toolbar panel, down - right, carrying the Slider and the
Container Drop-down List.
packVol works with one document at a time, as any other single document application, but you can open a diﬀerent document with no need to quit the application. The
program asks for closing and saving when there is a currently unsaved document.
For saving of data the program uses files with 3dp extension (the application icon is
). During installation the extension is added to the system registry, so that the files
can be opened by double clicking or via drag & drop.

Menu Bar
The various commands are organized in the menu sections File, Options, Settings,
Tools, Solution, Database, Report, View, Help.
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Menu File
Here you find the commands to open, save, import and print the document.
Command

Description

New [Ctrl+N]

Creates a new document by dropping all data and results.
Before performing the operation, the program asks to
save any modification.

Open [Ctrl+O]

Opens an existing document.

Import (Excel) →

Import Master Data [Ctrl+Shift+M] Imports the full load
list from an Excel file. See Import Master Data for details.
Import Code/Qty [Ctrl+Shift+Q] Defines the load list via
code/qty pairs, by selecting the package from the internal
database. See Import Code/Qty for details.

Export (Excel)

Exports data on a Excel file.

Import (ODBC)
[Ctrl+Shift+Q]

Imports data from an ODBC data source. See the section
Import data via ODBC for details.

Export (ODBC)
[Ctrl+Shift+S]

Export data to an ODBC data source. See the section
ODBC Export for details.

Import Container

Imports the types of containers to be used in optimization. See the section Import Containers for details.

Paste from
Clipboard
[Ctrl+Shift+V]

Pastes data from the system clipboard to the current
document. See the section Clipboard on how to format
data.

Copy to
Clipboard
[Ctrl+Shift+C]

Copies data of selected rows to the system clipboard as
tab-separated lines. You can paste to any application
supporting textual data (e.g., Notepad).

Save [Ctrl+S]

Saves on file the current document.

Save as...

Saves the current document with a new name.

Save Partial Data →

Save Loaded Packages
Save the list of loaded packages and containers used in
the current solution.
Save Unloaded Packages
Save the list of packages that are not been loaded.
Save Selected Rows
Allows you to save on file only the selected rows in data
tab.

Print Report
[Ctrl+P]

The entry becomes active when the Report is visualized
and allows to print it.
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Command

Description

Print
Preview

The entry becomes active when the Report is visualized
and allows to open the print preview manager.

Save Report

The entry becomes active at end of the optimization run
and allows saving the Report as an html document.

Open Recent

The program keeps a list of the most recently used files,
up to a maximum of nine entries. By clicking on a voice,
the corresponding file is opened.

Exit [Ctrl+Q]

Quits the application.

Options Menu
Here you find the commands to change at any time the properties of the visualization area. The default values can be set in the Options section of the Preferences
Dialog.
Command

Description

Black Stage [Ctrl+B]

Allows to choose the background color of the visualization
area between black, if selected, or white.

Info Under Mouse
[Ctrl+U]

Information on packages and containers are shown under
the mouse pointer. The function is left as an option because it can produce slowdowns with outdated hardware
and can be ineﬀective in manual mode.

Enable Item
Highlight

When the command is selected, the program highlights
the row in the Package Panel grids corresponding to the
item currently under the mouse pointer.

No Warning
Dialogs

The program warns with diﬀerent messages when a solution becomes invalid, giving you the possibility, when
appropriate, to revert the action. Select the entry if you
prefer to disable those notifications.

English pdf
Load Plan

Enabled only in non-English versions of the program.

Settings Menu
Here you can set the properties and behavior of the solver and open the Preferences
dialog.
Command

Unusable
Section

Description

The command is enabled when there is only one container
visualized on the main view (use the Container DropDown menu or the contextual menu to change selection),
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Command

Description

and opens the Unusable Section dialog window, where
you can define and/or delete a unusable section for that
container. Once set, the section is shown as a shadowed
gray block. For a unusable section, no box will be stowed
inside the section.
Preferences

Displays the Preferences Dialog, formed by various windows grouping the user settings. All changes made are
permanently saved and loaded at start up. Some settings
are updated for the current session.

Metric Units

Displays the dialog window where you set the Metric Units.

Disable loading
rules → Disable

The program automatically disables the check of a constraint whenever it is useless (e.g., the longitudinal ordering if no order is defined in the Package Panel). The
command opens a sub-menu where it is possible to force
the program to disable some constraint.
Minimum Check relaxes the constraint on the minimum
number of packages to be loaded (parameter min).
Bearing Surface Check does not keep into account the max
box overhang fixed in the Current Container tab or in the
Space grid (parameter overh).
Stacking Check ignores stacking indexes st and stack
matrix elements regulating the vertical order.
Set / Batch Load does not keep into account set load
(parameter set) and batch load (parameter bat).
Stacking Load Check does not keep into account the
maximum bear weight that a package can sustain (parameter mw).
Matching Code neglects the rule which ensures that the
package has to be loaded only in a given container
(parameter mc).
Max Load Check does not keep into account the Maximum
Load assigned to a container.

Cancel read-only
status

Data loaded from the database or imported from an Excel
file or via ODBC can be set as read-only to prevent accidental modification of the input data. The option can be
set in the Configure Database dialog box. The command
eliminates the read-only status.

Improve Solution

This option only applies to the automatic calculation.
The program implements a statistical method when
searching for the best solutions. The option restarts the
calculation from the current solution. In case of complex
load plans you may obtain an improvement in terms of
volumetric occupancy.
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Test settings are intended as options to check how the various constraints aﬀect the
solution. At end of calculation or whenever a document is modified, all Case Settings
are automatically deselected. This choice has been made to avoid that, by forgetting
the case setting state, one obtains results which are apparently inconsistent.

Tools Menu
Here you find the most important commands which allow to execute the calculation
and to set the loading rules.
Command

Description

Start Evaluation
[Ctrl+R]

Starts execution of the optimization or the manual session. The command is enabled when the tab in the Solver
Panel is set on Automatic or Manual.

Open Constraint
Panel
[Ctrl+D]

Opens the Constraint Panel. This auxiliary window
permits to define, in a intuitive mode, the allowed positions ps for a package, and to impose easily all constraints.

Open Group
Dialog

Opens the Set Load dialog window. The dialog allows
you to define which items have to enter a set group, or to
delete existing groups.

Open Stack
Matrix

Opens the Stack Matrix Panel, which shows in visual
mode all stacking rules, and allows definition of exceptions to the stacking between pairs of packages.

Open Destination
Dialog

Opens the Destination Dialog, where you can define the
type of ordering for packages with assigned destination
index (parameter ds).

Solution Menu
Here you find the commands to deal with the load plan solution created by the
application.
Command

Description

Start from
Current →

Keep fixed: by checking the voice before starting a run all
packages already loaded are kept in fixed position. See
Start from Current Solution.

Modify Solution →

Allows manual editing of the current solution. The entry
shows a sub-menu with two options
Keep fixed item qty checks that the numbers of packages
don’t exceed the values in the qty cells of the Dimen.
grid.
Don’t fix item qty the previous check is not performed.
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Command

Description

Redistribute Load

In the case of a optimal multi-container solution, optimizes again the solution by placing the packages in the most
uniform possible way among the various containers.

Output Selection

The menu commands replicate those present on the
Output tab. The sub-commands allow you to perform
some operations on the containers selected in the Output
tab.
save selected saves the load plan of the containers entering the selection.
re-optimize selected starts a new optimization of the
containers entering the selection.
remove selected removes the selected containers while
eliminating from the load list all packages contained therein.

Merge Solution

Allows you to “merge” the current solution with another,
previously saved on file.

Remove unused
container(s)

Removes all empty containers.

Delete solution

Deletes the optimization solution while preserving all
input data.

Database Menu
Here you find the most important commands which allow to configure the internal
Database, to retrieve item definitions, and to manage the ODBC connection.
Command

Description

Open Package
Manager →
Data Retrieval

Displays the Package Manager in retrieval mode, used to
transfer the package data stored in the database onto the
Package Panel.

Open Package
Manager →
DB Maintenance

Displays the Package Manager in maintenance mode,
which allows you to insert, modify, or drop the database records.

Save Items to
Database

Saves the rows selected in the Dimen. grid into the database. A row can be saved if you have defined the three
dimensions of the package and the code.

Open Container
Manager

Displays the Container Manager, a dialog window listing
all containers saved into the database. Once opened, the
load plan view is substituted by a preview of the selected
container.
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Command

Description

Configure
Database

Opens the dialog window used to Configure the Database.

Manage ODBC
Connection

Duplicates the connection management dialog ODBC.
The command is always available, even in case the database management is password protected.

Manage ODBC
Load List

Opens a window that displays the load lists that can be
imported via ODBC. The window allows you to assign
their status. See the section ODBC Import for details.

Import / Update
Database →

→ Data from ODBC, → Data from Excel.
Allows you to rebuild the entire internal Database by
importing data from a data source or from Excel sheet.
See Import Database.

Export to
Excel file →

→ Data from ODBC, → Data from Excel.
Allows you to save the content of the internal database
on a Excel file.

Use the Import / Update Database function with caution, because it leads to deletion
of all data stored in the database at time of import.

Report Menu
Here you find the commands to create and visualize the reports. All tools, except
from View Weight / Density and View Destination List which are always enabled,
become active only at the end of calculation.
Command

Description

View Report

Once selected, the load plan view is substituted by the
Report Window which shows a brief report about the
optimization results.

Create Load Plan →

Manual Creation The tool is enabled only at the end of
calculation and starts a work session where you can manage the visualization of the load plan corresponding to the
solution. The work can be saved on file in pdf format.
See the section Create Load Plan for additional details.
Export Load Plan in pdf format [Ctrl+E] The tool allows
you create the Load Plan Report in pdf format for all
containers entering the solution. The command opens
the Pdf Exporter dialog box where you can set the print
parameters and choose the container range.
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Command

Description

Measurements →

View Empty Spaces Allows you to view and measure the
unused spaces in the container. See View of Empty
Spaces for details.
View Weight / Density Allows to check visually the weight
distribution of the current solution. See the section Load
Distribution for additional details.

View Destination
List [Ctrl+Shift+D]

Opens the Destination Grid, showing the list of destinations ds. Using the grid you can insert short notes about
the numerical indexes and choose the color for each destination.

View Menu
Here you find the commands used to modify how the load plan is shown in the
visualization area. The view can be rotate by dragging the mouse while holding the
left button down.
Command

Description

Restore [F5]

The view can be altered in many ways with the commands described in the following. The command restores
the initial view.

Zoom in [Up]
Zoom out [Down]

The view depth can be changed by acting with the mouse
wheel. The commands performs the same operations and
allows to use the Up/Down arrows as acceleration keys.

Quad View

Switches from the standard axonometric view to the
quad-view. In the latter case the screen area is divided in
four viewports (axonometric, frontal, top, lateral view).
The mouse action is limited to the axonometric view (topleft part).

Special rendering ..

The item carries a sub-menu having two options, useful
in manual mode.
Wire frameVisualizes the box edges only.
TransparentVisualizes the box edges only.

Hand tool

When the command is activated, the mouse gesture
translates the container view.

Slider on
Load Sequence
[Ctrl+L]

When the command is active, the slider shows the load
sequence of boxes or of blocks of identical boxes. The
sequence ordering is fixed by means of the choices “Load
Sequence ..” of this menu.

Slider on
Shrink Boxes
[Ctrl+K]

When the command is active, the slider shrinks the
dimensions of the box edges while keeping unchanged the
position of the center-of-mass of the package.
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Command

Description

View by
Grouped Blocks

In addition to the standard view by single package, the
program can display the load plan by groups of identical
packages.It is recommended to use this feature if the number of boxes is large, say of the order of thousands of
items, or if you don’t have an accelerated 3D graphics
card.

Load Sequence .. →

The item carries a sub-menu having three options, which
control the ordering of the load sequence.
Bottom-Top Sequence shows the sequence of packages
according to Bottom-Top order, starting from the bottom of the container upwards;
Rear-Front Sequence shows the sequence of packages
according to Rear-Front order, starting from the rear of
the container towards the front;
Container Default Sequence defines the sequence according
to the value of the Pack: list box inside the Current tab
of the Container panel.
At the end of a manual session these three commands are
active only when the option reorder box sequence at end of
work session in the Advanced tab of the dialog Preferences
is checked.

Special Colors .. →

You can associate colors to particular variables.
By FI/LO order associates the package color to the destination ds;
By Set Groups associates the color to the set group set,
graying out those packages that do not enter a proportional group;
By Stack Index associates the color to the stack index stk,
graying out those packages that do not have a defined
index.

Show “Casting
Spaces”

Shows/Hides the spacing around the packages (parameters sp), in case these have been set.

Hide Unusable
Sections

Hides/Shows the unusable sections, in case these have
been set.

Full Screen [F11]

Turns on/oﬀ the program into full screen mode.

Hide Left Panels
[Ctrl+H]

Hides/Shows all left panels as to maximize the visual-

Center of Mass

Activates the visualization of the center of mass, shown
as cross-hair.

ization area. The corresponding tool
Auxiliary Toolbar.

is present in the
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The menu item Load Sequence .. and the option Pack: in the Current Container
panel are unrelated. You can choose the Bottom-Top Sequence in the Current panel
and then visualize the load plan according to the Rear-Front slider Sequence, or vice
versa. See the section Define the load sequence for details.

Help Menu
Contains tools to access online help and to register the product.
Command

Description

Help Contents

Displays this Guide in chm format.

Help on
Constraint Panel

Displays a message which reminds you that short descriptions of the fields in the Constraint Grids can be
obtained by clicking on the column labels.

Register packVol ...

Shows a dialog prompting for user and registration details
to validate the license of your copy of the program.

About packVol

Displays a window showing information about the program:
version, copyright, registration.

Check for
Updates

Opens a page at www.packvol.com via the default
browser to check for the presence of program updates.

Tool Bar
The most frequently used menu entries have an equivalent command in the tool bar,
according to the following association.
New

Open

Save

Start from Current

Start Evaluation

View Summary Report

Create Load Plan

Export Load Plan

Weight / Density

Preferences

Package Manager - Retrieval

Package Manager - Maintenance

Save Record

Container Manager

Configure Database

Constraint Panel
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Set Load Dialog

Stack Matrix

Restore original view

Quad View

Hand Tool

Block View

Slider on Contract Boxes

Special Colors

Full Screen

Help

Status Bar
The status bar is divided in three parts: left, center, right.
Left:
the pane carries information about the selected menu tool. During a manual session
it reports instead the item code of the selected package, and a short message about
the positioning of the box.
Center:
during a manual session the pane reports some basic information about the selected
package:
Box [L=92 W=81 H=55] @ [184 81 0] - pos: 04 - item ID: 1 cntID: 2
means, e.g., a box with ID 1 having length 92, width 81, and height 55 positioned
with orientation 04 at coordinates 184, 81, 0 (respecting the convention about length,
width, height as used for the container) of the second container. A small progress
bar appears when saving the pdf file of the load plan.
Right:
the pane shows the complete path of the opened file.

Report Controls
The text fields show the values of the global
parameters of the optimization: number, volume,
weight of the packages and of the containers, in input and after the optimization.

Visualization area
The visualization stage occupies most of the program window area and usually shows
the load plan view. You can visualize the load plan in axonometric or stereographic
view (see figure) by pressing the command View → Quad view
. The program
employs many auxiliary windows to perform specific tasks. When opened, these
windows temporarily hide the visualization area or, in some cases, occupy the whole
application area.
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To maximize the visualization area, the
panel window on the left can be temporarily hidden by using the command View →
Hide Left Panel or by pressing the corresponding tool
found in the Auxiliary Toolbar. The width of the left panel can be
changed by dragging the black bar that appears by clicking on the edge separating the
panel from the main window on the right.

At the end of a working session all packages whose color has not been chosen by the User,
are colored automatically by the program. Whenever you modify a constraint and/or
the quantity of packages, the load view is rendered with pastel colors to stress that the
shown solution is no more in sync with the panel data. By changing dimensions, both
for packages and containers, or by changing the type of container, the solution is erased.
Input data are preserved.

Using the 3D View
• the mouse wheel enlarges/narrows the load plan view. You can also use the
menu tool View → Zoom in/out or the keys Arrow Up/Arrow Down;
• the view can be rotated around the center of the ideal rectangle bounding the
containers by moving the mouse while holding the left button down;
• The view can also be translated by means of the same mouse gesture after
checking the command View → Hand tool
;
• the command View → Restore

restores the initial load plan view.

3D View Menu
Pressing the right mouse button activates a popup menu. This menu contains the
code of the package and the name of the container under the mouse pointer, and
the following commands:
Command

Description

Go to definition
[line n.]

Selects the row of the Data Panel corresponding to the
package under the mouse pointer.

Show container n.

If the solution contains more than one container, selects
the container under the mouse pointer.It acts exactly as
the Container List combobox.
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Command

Description

Show all containers

Undo the previous action, and shows all containers entering the solutions.

Save load plan n.

Allows you to save a 3dp file with the data of the selected
container.

Add cnt n. to selection

Add the container to the active selection of the Output
tab.

Reoptimize cnt n.

Starts a new optimization (i.e., redistributes the load) for
the container under the mouse pointer.

Panels
All commands for data manipulation are organized into two Panels located on the
left of the main window: the Solver Panel and the Data Panel.

Solver Panel
The Panel is formed by three tabs. The Automatic and Manual tabs show the startup parameters of the Solvers and allow you to select the method you want to use in
the session. The third tab, Messages, is used to display warning messages and info.

Data Panel

Input / output data are managed within the Data Panel. The two buttons Packages
and Containers allow you to quickly select the Package Panel, for managing the
package data, and the Container Panel, for managing container data. Above these
buttons a label reminds the metric units currently in use.

Auxiliary Toolbar

The toolbar contains four main controls. One of them, min Dim., is normally hidden.

min Dim.
The text box is active when you visualize the empty spaces and allows you to set
the minimum size of the displayed objects.
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Hide Panels
The tool
allows you to hide/show the Panel on the left as to maximize the
workspace area.

Slider
The slider
allows you to change the view of the load in two diﬀerent ways,
deformation mode and sequence mode.
Option

Description

sequence mode

it is active when you select the tool View → Slider on Load
Sequence (tool
depressed). In this case the slider arrow
shows/hides the sequence of loaded packages or blocks of
packages.

deformation mode

it is active when you select the tool View → Slider on Shrink
Boxes (tool
pressed). In this case the slider arrow
shrinks the dimensions of the boxes while keeping their
center fixed.

The command View → View by grouped Blocks
toggles between the view by
blocks or by single package. The ordering of the sequence is set by choosing one of
the items in the menu entry View → Load Sequence ...
If the solution includes multiple containers and you set the sequence mode, the slider is enabled only when you select a single container. Instead, it is always active in
deformation mode.

Container List

The drop-down list lists all containers and allows you select one of them. The same
action can be obtained by opening the contextual menu of the workspace area or by
using the Output Tab toolbar.
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Package Panel
The Package Panel reports in tabular form data and parameters of the packing list
and is activated by clicking on the tab Package.

In the User Interface of the program the properties of an item are divided into seven
tabbed grids, easily accessible with mouse click, plus one additional grid that can
be accesses via menu command.
1)
2)
3)
4)
5)
6)
7)
8)

Dimen., contains code, input quantity, and dimensions;
Desc., contains color and description of the items;
Box, contains weight and priority rules;
Pos, contains all positional constraints;
List, contains constraints applying on the current list;
Hand., contains settings for handling of the packages;
Space, contains settings for empty spaces and columnar ordering;
Destination, shows a summary about destinations.

Data can be entered:
•
•
•
•
•
•
•

by manual input, to perform tests or modify the packing list;
by data retrieval from the internal database;
by importing from Excel file with code/qty option;
by importing data from Excel file;
from any external database with support for the ODBC protocol;
by entering the item code in a cell;
by pasting from the system clipboard.

The input values follow a specific encoding, whose knowledge is required only if you
plan to import data from external sources. Whenever you type in a cell that refers to
a constraint, the program automatically displays the Constraint Panel, which oﬀers a
complete graphical environment to enforce intuitively all loading rules, as shown below
in the case of the Pos grid.
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Dimen. Grid (Dimensions)

qty

number of packages

h

package height

l

package length

code

identifier string of the package
item

w

package width

pk

number of packages loaded in
the current solution

qty - number of packages

In the qty cell you input the number of packages for this particular item. At the
end of calculation the cell may acquire a yellow color to remind that the item has
been partially loaded.
l, w, h - dimension

The fields l, w, h are integer valued. The length unit measures are those defined in
the Metric Units dialog window and are reported on top of the grid for convenience.
code - package code

The code is an alphanumeric string. In the load list the duplication of code is
allowed. If you enter the code of a record present in the internal database, the
definitions of the item are automatically retrieved (see Retrieval by code).
pk - loaded packages

After optimization they the number of loaded items. Cells of the fields pk are always
read-only. The color of the cell is that defined in the c field of the Desc. grid, or
the destination color if you activate the option special colors.
At the end of calculation, by clicking on a cell pk all boxes of that item are hidden from
the view. By clicking a second time the group is shown again.
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Dimen. Grid Menu
Command

Description

Add package(s) from DB

Opens the database window in retrieval mode.

Select all [Ctrl+A]

Selects all rows.

Delete selected rows
Ctrl+X

Deletes selected rows from all grids.

Copy selected rows
Ctrl+C

Allows to copy selected rows.

Paste copied rows
Ctrl+V

Allows to paste into the Panel the copied or deleted
rows, updating all grids.

Paste from Clipboard
[Ctrl+Shift+V]

Replicates the command present in the File Menu.

Copy to Clipboard
[Ctrl+Shift+C]

Replicates the command present in the File Menu.

Add rows to
database (box, plt)

Stores selected rows into the database, without the
need to open the Package Manager. When the
option Enable load by objects is enabled, you may
save as box or plt type.

Show all type

By clicking on a colored cell pk, all packages of
that type are hidden from the view. The command allows to restore the original view.

Hide all type

The command hides all packages from the view.

Desc. Grid (Description)

code

identifier string

[other] [optional description]

descr.

notes and User comments

c

color of the item

code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.
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descr. - description

The field is used to enter optional notes and descriptions that are then included in
the load plan report.
other - optional description

The field is displayed when you enable the option Enable secondary description field
in the database configuration dialog. You can use the field to enter an additional
description of the item..
c - package color

Clicking on a cell opens the standard Color Dialog, which allows you to assign a
color to the item. The value 1 indicates a User defined color.

Desc. Grid Menu
Command

Description

Select all [Ctrl+A]

Selects all rows.

Cancel User color

Cancels the color chosen by the User.

Set Random color

Chooses the package color randomly.

Show all type

By clicking on a colored cell of the rightmost column, all packages of that type are hidden from the
view. The command allows to restore the original
view.

Hide all type

Hides all packages from the view.

Box Grid (Single Box Constraints)

code

identifier string

bat

batch size

wt.

package weight (value with two
decimal digits)

set

item entering a set load group

qt/b

number of “objects” of the
single package
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code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.

wt. - package weight

Weight of the package. Must be expressed in the same unit of measure used in
Current Tab of the Container Panel.

qt/b - number of objects

The field defines the number of “objects” forming the package. The column is
shown only when the Load by objects setting in the Preferences dialog is active. See
the section Utilize the load by objects for details.

bat - batch load

The rule is useful for multi-container solutions, to control the spread of packages
among the containers. When used, the packages are loaded in each container in
multiples of the bat number. The rule is very strict and in case of a single container,
it is often preferable to use the parameter min. If the input quantity qty is not a
multiple of bat, a dialog window helps you correct the input. The zero or the empty
value eliminates the constraint.

set - proportional (set) load

The program implements the Load by Ratio (Set) load in the general case, namely,
when only a subset of items are grouped (e.g., [table,chairs] in ratio (1:4) + beds in
any number). The program calculates the proportions automatically from the item
with minimum quantity. For example, if you define a set with elements A, B and
C, with qty equal to 10, 20 and 42 respectively, the program loads the packages A,
B, C respecting the proportions 1:2:4. The rule is very strict and in the previous
example 2 objects of type C are always left on the ground. You can enforce this
constraint using the dedicated dialog Set Load.
The field set is read-only. Double-clicking on a cell opens a dialog that allows the
selection of the items forming a Set-Load group.
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Box Grid Menu
Command

Description

Select all [Ctrl+A]

Selects all rows.

Show all items

By clicking on a colored cell on the rightmost column, all packages of that type are hidden from the
view. The command allows to restore the original
view.

Hide all items

The command hides all packages from view.

Help about
the constraints

The command reminds to click on the grid labels to
get a description of the constraints.

Pos. (Position Constraints) Grid

code

identifier string

nf

numerical identifier (0-63) of
no-floor constraint

ps

numerical identifier (1-63) of
the allowed positions

xs

summary of max stack and
max height constraints as set
in the Constraint Panel

fl

numerical identifier (0-63) of
floor-only constraint

mw

maximum load that the box
can sustain if uniformly distributed

tp

numerical identifier (0-63) of
top-only constraint

Whenever you edit a cell the program automatically displays the Constraint Panel in
position mode, which oﬀers an intuitive graphical environment to apply the constraints.
After you make a change on the Panel, the numerical value in the grid cell is immediately
updated. Similarly, if you input a numeric value in a cell, the Panel immediately reflects
the change.

code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.
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ps - allowed positions

The constraint ps indicates numerically, with values included between 1 and 63,
the base and orientation, for a total of six positions, in which a given package can
be loaded. Easy to remind values are: 1 (the package cannot be rotated), 3 (only
the positions corresponding to rotations about the vertical axis), 63 (all positions
allowed). See the section Position Codes for a full description of the numeric codes
and for their use in the import process.
fl - floor-only

If not empty, the field fl indicates that that package must be loaded only on the floor
of the container. The numerical values, between 1 and 63 (see Position Codes), define
the positions for which the constraint has to be applied. The zero or empty value
eliminates the constraint.
tp - top-only

The field tp indicates that packages of diﬀerent type, or of same type but with a
diﬀerent orientation, cannot be placed on top of it. When the rule is applied the
whole space above the package is considered as unusable. The numerical values,
between 1 and 63 (see Position Codes), define the positions for which the constraint
has to be applied. The zero or the empty value eliminates the constraint.
nf - not at floor

The field nf is the opposite of fl, and forbids the positioning of the package at floor,
thus forcing the package to stay above others. It is possible to stow other packages
on top of an item marked as nf, as long as these have a stacking index strictly higher
to st. The numerical values, between 1 and 63 (see Position Codes), can be applied
for each face. The zero or empty value eliminates the constraint.
xs - max stacking and max height

Max height
165

max stack 3

H = 30
H = 35

The cell xs sums up the values of the parameters max stack and max height as set in the
Constraint Panel. The cell shows a numeric
value in case max stack has the same value
for all positions, while shows the letter “Y”
in the case of a complex rule. The cell is colored in red if max height has some nonzero
values.

max stacking - max stacking

The field max stacking is applied only for packages marked as fl, tp, or nf, and defines
how many packages of same type and with same orientation can be stacked one on
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top of the other. The zero or empty value eliminates the constraint, in which case the
“pile” can have arbitrary height. The zero or empty value eliminates the constraint.
max height - max height

Except in the case of the constraint “floor-only” fl, the max stack parameter alone is
not able to control the maximum height at which a package is placed, because this
depends on the “level” at which the stack starts (see figure). Sometimes it may be
necessary to prevent that certain packages are placed too close to the ceiling, namely
that they exceed a certain maximum height. In these cases you use the max height
parameter, which indicates the maximum height at which a package can be placed.
The parameter may be imposed for each position by means of the Constraint Panel.
For all positions marked as fl the corresponding check-box are disabled, to avoid
conflicts with the value of max stack.
mw - maximum weight supported by the package

This is the most powerful constraint to impose the ordering in the vertical direction
of the load plan in a realistic way. The value can be defined for each face and refers
to the case where the weight is uniformly distributed on the base face. The field
blank or zero is seen as a signal that the constraint should not be implemented. If
you need to forbid the positioning on a face, please impose a very small non-zero
value, for example 0.01.
Technically, the program requires a value
of weight but converts it internally in the
Kg 80
normal stress through division for the area
of the supporting surface. Hence, in a situatmw 100
ion as depicted in figure, the object cannot
be positioned above because, although its
weight is lower than pm, it generates a stress
higher than the maximum allowed.

Both xs and mw fields can be edited. The entered value is associated to all allowed
positions. The xs value is associated to max stack parameter. To diﬀerentiate the value
according to positions, or to enforce the max height constraint, you have to employ the
Constraint Panel.

Pos. Grid Menu
Command

Select all [Ctrl+A]

Description

Selects all rows.
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Command

Description

Allow all positions

The package can be placed in any position (ps 63).

Only horizontal positions

Only the positions corresponding to rotations about the
vertical axis are allowed (ps 3).

Reference position only

Only the position corresponding to the edges as defined
in the Dimension tab is allowed (ps 1).

Set allowed positions

Opens a dialog where you can impose an arbitrary value
for the ps position parameter.

Set as floor only

The package should be placed only on floor. The constraint is applied to all allowed positions (fl = ps).

Cancel as floor only

Cancels the previous condition.

Set as top only

Forces a package to sustain only packages of same type
and position. The constraint is applied to all allowed
positions (tp = ps).

Cancel as top only

Cancels the previous condition.

Set as not at floor

The package cannot be positioned at floor. The constraint is applied to all allowed positions (nf = ps).

Cancel as
not at floor

Cancels the previous condition.

Set common rules

Opens a dialog where you can quickly set the values of
max stack, max height and max bearing weight mw for
all currently selected rows.

Cancel all rules

Cancels all applied rules, restoring the default values.

Show all items

By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command restores the original view.

Hide all items

Hides all packages from the view.

Help about
the constraints

Reminds to click on the grid labels to get a description
of the constraints.

Quick setting

You can employ two dialogs to quickly set a common value for various constraint.
These dialogs are opened via the contextual menu of the Pos. grid. The rules are
applied to all records currently selected in the grid.
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Set allowed positions
Assigns the same value ps to all selected items.

Set parameters
Assigns the same value max stack, max height and max
bearing weight mw to all selected items. In case you need
to restore the default value, leave the text fields blank and
press OK.

List (List Constraints) Grid

code

identifier string

mc

container “matching code”

ds

numerical identifier of the destination

stk

numerical identifier (≥ 0) of
the stacking order

min

minimum number pr priority

code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.
ds - destinations - loading order

The numerical identifier ds defines the priority and/or the longitudinal ordering
along depth (L axis). The value zero (or empty cell) is assumed as the signal to
disregard the constraint. The rules to be applied can be defined in Destinations
Dialog. If you impose priority rule, packages with lower ds index are loaded first. In
case you apply longitudinal ordering, the packages are placed from the rear of the
container in ascending order with respect to ds. The parameters of the Destinations
Dialog allow you to specify how blocks with the same destination should be grouped,
or to temporarily disable the constraint without the need to alter the ds values. The
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two constraints can be applied simultaneously. The priority rule is only important
in the case of solutions with fixed number of containers and when it is expected that
not all packages can be loaded.
min - minimum numbers / priority rule

The min field can be used in two ways
minimum number: in case you input a positive value, the solver tries to load at least
this number of packages for the given item. The constraint applies only in automatic
mode. The solver reports a warning whenever it’s not able to find a solution.
priority: the value is treated as a priority index. Packages with lowest index are
loaded first. It’s equivalent to the ds priority but the program does not impose any
sort of ordering.
mc - container “matching code”

You can force the program to load a package in the nth container by setting mc=n.
The containers are implicitly numbered from 1 to the maximum number in the input
list. A value of zero or the null field removes the constraint. The parameter mc thus
allows to work on diﬀerent load plans simultaneously.
stk - stacking index

Instead of the value mw, which is not always known, you can use the stacking index
st, which oﬀers an alternative way to define the vertical ordering. The binding to
an item of a positive number stk imposes the rule that no package with lower stk
value can be placed over this. The zero or empty value cancels this constraint, and
then the package can be positioned above or below any other, except above packages
marked as tp.
If you edit the stk field, the value is associated to all allowed positions. To diﬀerentiate
the value according to positions you have to employ the Constraint Panel. In this case,
the cell displays the letter “Y” as a reminder of a mixed rule.

List Grid Menu
Command

Description

Select all [Ctrl+A]

Selects all rows.

Cancel
destination

The command eliminates all destination indexes ds.

Cancel matching
code

The command eliminates all container indexes mc.
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Command

Description

Show all items

By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command allows to restore the original view.

Hide all items

The command hides all packages from view.

Help about
the constraints

The command reminds to click on the grid labels to get
a description of the constraints.

Handl. Grid (Handling Constraints)

code

identifier string

depth

tpl

check (0-3) of placement when clm
operated via forklift

overh

max box overhang (%)

max depth
parameter for columnar ordering

code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.
tpl - handling by forklifts

Enforces control of the handling by forklifts. If you set tpl=3,
the program checks that there is enough space for the complete
rotation of the package. The figure below shows the excluded
positions (in red), in case you impose the constraint.
You can assign the value tpl=1, in which case the control is
carried out only with respect to the base position, or you can assign tpl=2, in which
case the control is performed with respect to the rotated position (see figure). The
value tpl=3 (2+1) corresponds to the union of two rules.
The constraint is usually employed when packages have ps=3 (only horizontal
placements). In all other cases, when tpl=1 the rule is applied also to the positions ps=8 and ps=32. Similarly, when tpl=2 the rule is applied to the positions
ps=4 and ps=16.
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ps=1, [8,32]

tpl=0

tpl=1

tpl=2

tpl=3

ps=2, [4,16]

The check of handling by forklifts is operated only for packages at floor level. For stacked
items you should use the columnar order parameter.

overh - max overhang

The program checks that the position of center of mass of each package lies within
the base (physical equilibrium).
The default value is taken from the text box Max box overhang
(%) in the “Current” tab of the the Container panel. The
field overh allows you to change the default value of specific
packages. The data is expressed as a percentage of the basis
edges (from 0, package must be completely contained inside
the base, to 49, the physical limit for the equilibrium). The empty field, or the
value -1, resets the default value.
bdepth - max depth

If you set a value greater than zero, the program checks the
maximum depth of a box with respect to packages that support it. This parameter is useful if the positioning of the upper
box is carried out using forklifts.

clm - column order

The last field allows you to specify the columnar order and the “free space at top”.
The basic values, which can be combined, are:
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clm=1 - “columnar order”
The package should stay within the base
provided by the lower package.
clm=2 - “face on face”
The surfaces between lower and upper
packages must coincide.
clm=4 - “only on vertex”
A vertex of the package must coincide with
a vertex of the lower package.
clm=8 - “free at top”
Allows you to stow a package in any position (ps=63) when it is placed on top of a
stack, regardless of the constraint currently
imposed.

The rules can be combined. For example, clm=5 (1+4) enforces the two constraints
clm=1 and clm=4 simultaneously.

Menu Handl. Grid
Command

Description

Select all [Ctrl+A]

Selects all rows.

Set columnar order

Adds (deletes) the value clm=1 to the current value of
clm, always erasing clm=2.

Cancel columnar order

Cancels the value clm=1 from the current value of clm.

Set as only on vertex

Adds (the value clm=4 to the current value of clm, always erasing clm=2.

Cancel as only on vertex

Cancels the value clm=4 from the current value of clm.

Set as “face on face”

Sets clm=2 as current value of clm.

Cancel “face on face”

Cancels the value clm=2 from the current value of clm.

Set “all positions when
at the top”

Adds the value clm=8 to the current value of clm.

Cancel “all positions when Cancels the value clm=8 from the current value of clm.
at the top”
Set Parameters

Opens a dialog where you can assign the value of overh
and max depth
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Command

Description

Cancel all rules

Cancels all applied rules, restoring the default values.

Show all items

By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command restores the original view.

Hide all items

The command hides all packages from the view.

Help about
the constraints

The command reminds to click on the grid labels to get
a description of the constraints.

Quick setting
The dialog box is opened using the contextual menu of
Handl. Grid and allows you to impose a common value for
max overhang overh and the max depth depth. The values
applied to all selected items. In case you need to restore
default value, enter blank and press OK.

the
the
are
the

Space Grid (Spacing)

code

identifier string

spH

reference of the parameters spL
and spW to the edges of the
container (if spH=-1), or to the
sides of the package (if spH= ≥
0)

spL

empty space around the package Rsp
(length side)

not available space at rear of
the container

spW

empty space around the package Fsp
(width side)

not available space at the front
of the container
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Whenever you edit a cell the program automatically displays the Constraint Panel in
spacing mode, which oﬀers an intuitive graphical environment to apply the constraints.
After you make a change on the Panel, the numerical value in the grid cell is immediately
updated. Similarly, if you input a numeric value in a cell, the Panel immediately reflects
the change.

code - identifier string

Identifier string, repeated from the Dimen. grid and unchangeable.
spL, spW, spH - lateral empty space

Sometimes it is necessary to leave some free space around a package (for example,
due to anchor hooks).
The parameters spL and spW specify the
Container width
amount of free space (“padding space”) in
the direction of the depth and width side,
respectively. The third parameter spH spspH≥0
spL=
spP=
ecifies the orientation of the free spaces.
When spH ≥ 0 (or empty) the orientation refers to the package (“relative”, see
figure). A non-zero value of spH is used for
packages that can be fully rotated when
spH=-1
spL=
spP=
the top is placed sideways.
If spH=-1, the orientation instead refers to
the container (“absolute”, see figure), regardless of the position of the package.
spH≥0

spP=

spH≥0

Length

spP=

Rsp, Fsp - spaces not available

Prevents placement of the package in rear (for a length Rsp) or at the front (for a
length Fsp) of the container.

Space Grid Menu
Command

Description

Select all [Ctrl+A]

Selects all rows.

Set empty spaces

Opens a dialog in which you can set the spacing for all
selected rows.

Cancel empty spaces

Cancels spL, spW, and spH, for all selected rows.

Set as absolute
spacing

Sets spH=-1, for all selected rows.

Cancel absolute
spacing

Cancels spH, for all selected rows.
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Command

Description

Cancel all rules

Cancels all applied rules, restoring the default values.

Show all items

By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command restores the original view.

Hide all items

The command hides all packages from the view.

Help about
the constraints

The command reminds to click on the grid labels to get
a description of the constraints.

Quick setting
The dialog box is opened using the contextual menu of the
Space Grid and allows you to impose a common value for the
spacing spL, spW, spH, as a percentage of the edge or as a
fixed value.
In case you want to reset the default value, enter blank and
press OK.

Destination Grid
The Destinations Grid has only descriptive fields and is used to assign a color of
your choice to the destination parameters, or to enter descriptions that are included
in the report, if required. The grid can be opened by pressing the menu command
Report → View Destination Grid [Ctrl+Shift+D].

ds

numerical identifier of the destination

label

description field

tot

number of packages per destination

pk

number of loaded packages
per destination

c

color, changeable by clicking on
the cell

When the grid is active the colors used in the visualization area are associated to

packVol 3.7.0 - User Guide - 34

the package’s destination. You may change color by pressing the cells on the column
c.

Destination Grid Menu
Command

Description

Show all type

By clicking on a colored cell of the rightmost column, all packages of that type are hidden from the
view. The command allows to restore the original
view.

Hide all type

Hides all packages from the view.

Cancel User color

Cancels the color chosen by the User.

Shared properties
The grids of the Package Panel share some common properties:
the field code is repeated all over the tables;
cells in the Dimen. grid are always writable and are used to type in data manually.
Instead, cells of the other grids are initially read-only. A row of these grids becomes writable when you input at least the box dimensions l, w, and h in the
corresponding row of the first grid;
each table has initially twenty-four rows. New rows are automatically added by
the program when needed;
each grid provides a contextual menu activated by right clicking on any cell, that
allows to perform some basic actions on the selected items;
to perform the selection, you can click and/or drag the mouse over the cells.
Hold the Ctrl key down to deselect a row from an existing selection. By pressing
the Shift key it is possible to select a group of contiguous rows;
when switching from a grid to another (e.g, from Dimen. to Desc.), selection is
preserved;
apart for the Desc. grid, all cells of the rightmost column behave as visualization
buttons, allowing you to hide or show items from the load plan view.

Constraint Tips
As an help, you can obtain a synthetic description about the meaning of the constraints by clicking on each column’s tab.
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Grid Status
When the option Settings → Start from Current is active, all the columns except
qty, code, description, and qt/b, are set as read-only and not-editable. Cells are
shown with green to remember that the values are referring to the packages already
loaded and that their content cannot be changed.
The option Protect data loaded from Database or from Excel in the Configure Database dialog box sets as read-only the previous columns for all records loaded from the
internal database, via ODBC or imported from an Excel file. This option is useful
to prevent accidental modification of the input data. Diﬀerently from the “Start
from Current” case, the read-only status can be eliminated at any time with the
command Tools → Cancel read-only status.
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Containers
To work with the containers, click on the icon
Containers. Data are organized
in three panels accessed can be selected by clicking on the tabs.
1) Current Tab, shows data and parameters of the container;
2) Input Tab, lists the types of containers to be used, and their number;
3) Output Tab, lists, in tabular form, information about the loaded containers.
The Current panel shows the container data. If the solution contains more than
one container, the panel becomes active once it’s shown a single container. You can
select a single container via:
• the drop-down menu found in the Auxiliary toolbar;
• the contextual menu of the Visualization Area.

Current Panel

The panel allows definition both of the container dimensions and of some parameters
relevant for the positioning of the load. You can input the data manually, or you
can retrieve the definitions from the internal Database or from an Excel file.
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To save the data in the database, press the icon Save Data
. A pop-up dialog
allows you to define the name of the container. Leave the field blank if you want to
cancel. The command Save Data in the Current Panel is the only way provided by the
program to insert container records into the internal database.

If you save a container already in the database, a control
window lets you:
– update the record;
– save the container with a diﬀerent name (the save
dialog is called again);
– cancel the operation.

L, W, H - Internal Dimensions

The input fields (L) Length, (W) Width, and (H) Height refer to the “inside”
dimensions of the container. The numerical data are integer valued.
Pack: - Packing Direction

The combo-box choices instruct the solver on how to stow the
packages.

Option

Description

Bottom-Top

The program places the packages starting from the bottom of
the container, filling the base, and then goes upward.

Rear-Front

the program places the packages starting from the rear of the
container, filling as much as possible a “slice” upward, and then
continues to the front of the container.

Layer-Front

It’s a combination of the previous two: the positioning follows
the Rear-Front order, but the height of the load is kept as low as
possible, by maximizing the base as in Bottom-Top ordering.

The diﬀerent settings become evident whenever you deal with partially loaded
containers.
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The choices are mutually exclusive. They are options for the optimizer, not related to
load visualization. The loading order can be changed by means of the corresponding
options in the View menu. The two parts are not related: you can, e.g., set the RearFront solver option and then choose to visualize or export the load plan according to
the Bottom-Top ordering. See Define the load sequence section.

Type: - Type

The combo-box shows the possible type of containers.
Option

Description

Closed cnt

This is a standard container, defined as any rectangular
object with fixed sizes that can accommodate smaller
objects. The program optimizes the load in the given
container trying to maximize the items quantities as
entered in the Automatic panel.

Open cnt

For this container optimization is performed with
respect to the height of the container, which doesn’t
have a fixed value and is kept as small as possible. In
this case the Pack: combo box is disabled because the
load sequence is managed by the program itself.

Rack

This is a special container, open on one side and with
usable height greater than its actual physical size (see
figure). It is described in the Appendix.

For Open cnt the program keeps the edge as small as possible but at the same time
tries to load the maximum number of the packages. The number of packages inside the
container is therefore indirectly controlled by other parameters (usually the Max Load).

Max Load - Max Load

The text field Max Load, having decimal values, allows you imposing the maximum
load of the container.
Edit Profile - Load Distribution

The program allows you to assign a maximum load for diﬀerent sections of the
container, up to a maximum of five sections. Press the Edit Profile
command.
In the dialog box choose the number of sections, and input the size and weight
assigned to each section. Whenever the data changes, the value of Max Load is
recalculated automatically.
Density - Density

When you set a load profile, the application checks that the weight of each section

packVol 3.7.0 - User Guide - 39

does not exceed the value set in the Load Distribution dialog. The box Density
triggers a rule to ensure that the load distribution remains uniform throughout the
length of the container. When this option is active, in every possible “strip” of
length L, the weight W of the strip must satisfy the relationship
W/L ≤ weight/length
where weight and length are the data entered in dialog Load Distribution.
Mean Density - Mean Density

In many situations the density should be understood as an average value to check
how much space should be occupied by heavy packages stowed on the floor. If the
option is active, for each package with weight w, the program evaluates the length
L needed to stow the package in accordance with rule
w/L = weight/length
where weight and length are the data entered in dialog Load Distribution. If L
exceeds the base length of the package, other packages are spaced appropriately.
Max box overhang - Max box overhang (%)

The input value controls the position the center of mass of
every package by imposing a limit on the overhang of a package
when this is stacked on another. The allowed value is expressed as percentage of the edge dimension, and varies from 0 to
49 (physical limit).For any package the default value can be
changed by acting on the cells overh of the Space grid.
Center of Mass - Center of Mass Constraint
(0,0)

28%

70%

65%

35%

The check box Enforce Constraint
forces the solution to have the center of mass inside limits expressed as percentages of the container dimensions, as depicted in the
figure. Use the input boxes DL (length) and DW (width) to set
the limits. There is no check in vertical direction.
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Forbid shift - Forbid shift

To fulfill the requirement on the center of mass, the program can shift the position of
blocks of packages or even of the entire load. The check box Forbid shift, if checked,
inhibits this functionality.
If the option Forbid shift is active, please do not input too restrictive limits for the
center of mass, otherwise the solver may not be able to find a solution.

Input Tab

The container Input Tab contains the list of container types to be used and their
number. During the optimization the containers are loaded according to the order
of the list. Except the first line, which is always defined at start-up, all rows are
entered by acting on the tool
(Add) in the panel toolbar, or via the same tool
in the main toolbar, or by using the menu command Database → Open Container
Manager. The tab contains three groups of controls:
• Container List,
• List Tools,
• Multi-Containers Options.
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Container List
The list reports the container types and has the following fields
Column

Description

name

container name. The field is editable and allows changing label.

qty

number of containers.

used

number of actually used containers (read-only).

List Tools
The panel carries a specialized toolbar which includes the following commands
Icon

Command

Description

Cancel

Deselects any active line.

Add

Opens the Container Manager to retrieve data.

Delete

Deletes selected rows from the list.

Clean

Deletes all the unused containers.

Edit

Displays the Current panel for editing purposes.

Clone

Duplicates the container row.

Delete All

Deletes the solution without altering the input data in
the Package Grids

You can add new containers without invalidating the solution. In this way you can employ
the Start from Current function, in case the program fails to load all packages in the
current list of containers.

Multi-Containers Options
Option

Fast Optimization

Description

If the check-box is deselected, the solver employes the
sequential method, where the containers are processed one
at a time.
When the check-box is selected, the solver employes the
concurrent method, where all containers are treated simultaneously.
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Option

Description

Add Container (Auto)When it’s active, and if the program is not able to load all
the packages into the assigned containers, the application
automatically adds new containers up to completion of the
load. The kind of container to be added is selected through
the dialog box shown in figure.
The default option is to employ the last container in the
input list. By clearing the check box you can select a diﬀerent type of container from those registered in the database.
Choosing the most appropriate method is left to the user, because the eﬃciency is too
dependent on the type of load plan.

The concurrent method might be better
– as a method of controlling the number of containers required, useful when combined with Add Container (Auto);
– whenever you employ complex ordering rules (set load, absolute destination order, etc.);
– when all containers are loaded with Rear-Front option.

Output Tab

The Output Tab shows in tabular form the percentages of load weight, used volume,
and number of loaded packages, thus providing a brief summary about the results
achieved in the optimization. Detailed information can be obtained by opening the
panel Summary Report.
The panel also oﬀers a number of tools that allow you to manipulate the solution
without invalidating the results.
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Toolbar
Icon

Command

Description

Clear

Deselects all active rows.

Save

Saves the load plan of the containers entering the active
selection.

Re-optimize

Starts a new optimization of the containers entering the
active selection.

Merge

Allows you to “merge” the current solution with another
previously saved on file.

Remove

Removes the selected containers while eliminating from
the load list all packages contained therein.

Show

Displays the selected container.

To add/remove containers in the active selection, double click on the corresponding line,
or click on the box shown in the second column. You can also use the contextual menu
of the work area.

Unusable Spaces
The program allows you to define irregular containers with unusable volumes. In
this way, during the optimization, no package will be placed inside these regions.
Such spaces must have “rectangular” shape and are divided between “unusable
spaces” and “unusable sections”. Unusable spaces are considered as a property of
the irregular container. Unusable sections, instead, can be changed as desired in
the solution and are not saved into the Database. If present, unusable volumes are
shown in transparency.
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Container with unusable spaces
You can define a container with unusable spaces in two ways:
By import
With the command File → Import Container you can import an Excel file appropriately formatted (see section Import Containers for details). If you need to
save the definitions in the Database, please select the Current Tab and click on the
Save
command.
By manual session
You can use a special manual session that allows you to visually locate the areas to
leave empty. First, enter the dimensions of the container in the Current tab of the
Container Panel. Then, enter in the Dimen. grid the dimensions of the “blocks”
that form the unusable volumes. It is not necessary to specify their number and you
can leave blank the cells qty. Choose the tab Manual and check the option Define
a container with unusable spaces. Then, start the session as usual. A dialog message
reminds that the program will work in this specific mode. With the present setting,
contrary to a standard manual session, the program does not perform constraint
checks, so that blocks can be placed in arbitrary positions. To place the blocks in
arbitrary points of insertion, define suitable “insertion points” following the instruction as discussed in the section about the manual mode. At the end of the session
a dialog allows entering the name of the custom container which is then stored in
the database. Leave the text field blank to cancel the operation and disregard save
of data.

Unusable Section
You can define unusable sections for each
single container. If your solution includes
multiple containers, you must first select the
container of interest via the container drop
down box.
To employ this feature, press the command
Settings → Unusable Section and enter the
extension of the unusable section in the text
fields of the dialog. You can also define an
eﬀective height of the container, to prevent
the placing of the packages near the “ceiling”
of the container. In this way is not necessary
to set the limit via the constraint maximum
height.
The command OK assigns or modifies the
section (the program ensures that the entered
values are distinct). The command Delete
eliminates the section. The command Close
closes the dialog without performing any operation.
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Constraint Dialogs
packVol oﬀers a four graphical environments for dealing with all loading rules in a
simple and intuitive way.
Constraint Panel

allows you to impose rules for individual packages.

Destination Dialog

allows you to enforce rules related to ordering of the
load plan.

Stack Panel
(with some variants)

allows you to view the stacking rules between pairs
of packages and to apply exceptions, if required.

Set Load Dialog

allows you to define which packages must be
grouped in case of set load.

Constraint Panel
The Constraints Panel is opened with the menu entry Tools → Open Constraint Panel
. The panel is also automatically displayed whenever you edit a cell of the Box
Grid, a cell of Space grid, a cell of Handl. Grid, or the cell stk of the List Grid.

Once opened, the load view is substituted by a view of all the six possible positions
of the package, shown with solid faces if the position is allowed, with wire-framed
edges if the position is forbidden. The package to be dealt with is selected by clicking
on the corresponding row of the Package Panel.
The positions are labeled according to the Encoding of Positions.

The Constraint Panel comes in two variants, the Panel Position, automatically
shown when you work with the Pos. and List tabs, and the Spacing Panel, shown
when you work with the Handl. or Space tab.
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In both panels, after any change is made, the numerical value in the grids is immediately
updated. Similarly, if you input a numeric value in the grids, the panel immediately
reflects the change.

Position constraints
By clicking on the appropriate controls, divided into six groups according to face
and orientation, you can impose all the constraints of the Box Grid and List Grid
tabs.

Please pay attention to the fact that at least one position should be allowed. If you
try to deselect all the check-boxes, the first position is automatically checked. In case
of manual input or automatic import, the program can change the numerical values in
order to preserve the consistency of the data.

The association between the controls of the panel and the cells of the grids is as
follows
ps

Allow

xs

max stack, max height

fl

floor-only

mw

max weight

tp

top-only

stk

stack index

nf

no floor.

as shown in the figure below.
As an help to the User, the controls are disabled when their values are undefined.
In particular:
– if an edge dimension of the package is not defined or the item is read-only, all
groups are disabled;
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– if a position is equivalent to a previous one, the whole group is disabled;
– if a position is forbidden, all controls of the group are disabled;
– the text-box for the max stack (xs) is enabled only if the package has been
marked as floor-only (fl), top-only (tp), or no-floor (nf);
– the constraint floor-only (fl) and no-floor (nf) are mutually exclusive, therefore
the program disables a check box if the other is checked;
– the max height text-box is disabled in case of floor-only position, to avoid
conflicts with the max stack value.

Spacing constraints
The Spacing Panel is automatically shown when you select Handl. or Space tab,
and allows you to enter the parameters in an intuitive way.
tpl

Handling by forklifts

The checkbox applies the rule of handling
by forklifts. The button change allows you
to assign the desired value for the parameter tpl. The positions subject to check are
shown with red color.

spL, spW, spH

Free space around
package.

The three text boxes allow you to enter the
value of the empty space around packages.
The Abs choice allows you to distinguish
between “absolute” or “relative” spacing.

overh, max depthMax overhang/
Max depth

Allows you to enter the values of Max overhang and/or Max depth.

Rsp, Fsp

Unavailable Spaces

The two text boxes are used to enter the
values of the unavailable spaces Rsp and
Fsp.

clm

Columnar order

Applies the columnar ordering, combining
the values chosen in the appropriate checkboxes.
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clm

Special
position

Applies the constraint “free at top”, adding
the suitable value to the parameter clm.

The following figure shows, using colors, the association among cells of the grid and
controls of the panel.

As an help to the User, the controls are disabled when their values are undefined.
In particular:
– if you activate the check-box Abs (spacing relative to the container), the textbox for the vertical dimension is disabled;
– if you impose Columnar Order, the text-box Max Item overhang is set on
zero and disabled;
– if you impose Set “face on face”, the text-box Max Item overhang is set
on zero and disabled together with the options Columnar Order and Only on
bottom vertex;
– when you enable the option Forklift handling, the option Set “face on face”
is automatically activated, although it can be changed at later time.

Constraint Panel Tools
The Constraint Panel has a toolbar at the bottom with the following commands
Command

Description

Back

Selects the previous row of the package grids.

Next

Selects the following row of the package grids.

Quick

Opens the contextual menu of the active tab, and operates only
on the selected package.
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Command

Description

Stack

Opens the Stack Matrix Dialog, where you can define “exceptions” to stacking rules.

Close

Closes the Panel.

Destination Dialog
The Destination Dialog is used to control the longitudinal distribution of the load.

It is formed by diﬀerent groups of controls. Most of them take into account the
destination parameter ds, some others are not related to ds.
- ds - min index as priority rule
Option

Description

ds - lowest indexes should A package is loaded only after complete loading of all
be loaded first
packages with lower ds value.
min - lowest indexes
should be loaded first

A package is loaded only after complete loading of all
packages with lower min value.

If you are only interested in priority, the two options are equivalent and you can use
indiﬀerently ds or min as sorting field. Min option allows you to reserve the ds index to
spatial ordering, making it possible to order the load both logically and geometrically.

- ds-index as First In / Last Out order

Packages are placed in ascending order with respect to the ds parameter, so as to
respect an order for loading/unloading .
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Option

Description

For each individual
container

The packages are ordered in each container, but no rule
is set between the containers.

Keep order between
containers

The packages are ordered by taking into account the
ordering between consecutive containers.

No order inside
container

The option is shown when the previous option is
selected. When active, the order is maintained among
diﬀerent containers, but not in each single container.

Disable FI/LO order

The option allows to disable temporarily the ordering,
without altering the parameters ds. Use this option if
you are only interested in using the ds index as priority
rule.

4

3

2

1

RELATIVE ORDER

ABSOLUTE ORDER

ABSOLUTE ORDER

DISABLED ORDER

(no “per-container” rules)

packing direction
Max Mixing

Max Depth

(top view)

max mixing - Max Mixing
Max Mixing

When FI/LO is active, the program always checks that no packages
with lower ds indexes are “in front of” or “above” others with higher indexes, but no check is performed in lateral direction. The
group longitudinal mixing [blocks] allows you a fine-tuning of the
overlap between blocks of packages having diﬀerent ds destinat-

ions.
Enable Max Mixing

The program tries to decrease as much as possible the
mixing between blocks with diﬀerent ds parameter.
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max mixing

Allows you to limit the extension of the overlap of
blocks of packages with diﬀerent ds destinations within
a maximum value that must be entered in the text box
with the red background.

open local settings

Shows the list of destinations. You can assign a diﬀerent
value for max mixing to each individual ds. The values
must always be entered in the red box after selecting
the row of interest.
The clear all button discards all entered values.

Please keep in mind that the empty field or a zero value for the max mixing text field
result in a diﬀerent behavior. The empty field allows the application to minimize the
overlap, while the zero value completely prevents the mixing. In the latter case, one
has a simple subdivision of the container in independent longitudinal sections. If there
are no particular needs, it is advisable to keep this parameter field empty, since max
mixing has a significant impact on volumetric eﬃciency. This is why the field has a red
background.

- Check loading / unloading for each package

The function does not require the entering of ds values. The program internally
assigns a fictitious ds index to each type, so that identical packages are always
grouped together, deciding which sequence is the best. The function is useful in
case you need to implement the sequential loading/unloading of the packages, or to
handle only one type at a time.

The Check loading / unloading for each package option can be combined with the First
In / Last Out order. In case only the loading/unloading control is active, diﬀerent
orders can be obtained however the packages will always be grouped together, as shown
in the figure.

packVol 3.7.0 - User Guide - 52

- Position / Balance

The set of rules is not tied to parameter ds.
Max Depth

The text box allows a predefined value to be set for
the depth constraint common to all packages. Therefore, only values other than the predefined one can be
entered in the Handl. Grid.

Rear balance check

If checked, the program checks that the back of the
package is resting against the wall of the container or
against another package.

The two options are competitive (Max Depth tends to “bring forward”, while Rear
Balance tends to “bring backwards”). If Rear Balance is set, do not assign an overly
restrictive value to Max Depth.

Stack Panel
This is opened through the menu command Tools → Open Stack Matrix
, and
it makes it possible to display the stack rules between pairs of packages resulting
from the setting of constraints fl, tp, stk and xs.. Upon opening, two tree-controls
allow the selection of any pair of items on the loading list (figure on the left). In
area to the right, the pairs are shown, with the upper package colored green if the
stack is allowed, or red if the stack is prohibited. The displayed combinations can be
reduced by expanding the items of the tree control and selecting the individual positions of the packages. The gray box above each figure shows the state (green/red)
and colored indicators of the applied constraints. Click on the gray frame to display
information on the stacking rule.

Stack Matrix
The panel is a powerful tool that allows you define “exceptions” to the default
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stacking constraints, in particular:
– to exclude stacking otherwise allowed;
– to allow stacking otherwise excluded.
The list of exceptions forms the Stack Matrix, and it is displayed by pressing the
Active
tool. Instead of the tree controls, a list appears that shows the imposed
exceptions (figure on the right). The first time it opens, the list is usually empty.
To exclude/accept a configuration, simply double click with the mouse over the image,
or use the commands of the Work menu. When an exception is activated, the upper
gray band becomes orange. The color of the indicator at the top left is always diﬀerent
from the color of the upper package.

Work menu
The menu opens by right-clicking on the work area or by clicking on the Tools
command.
Command

Description

Deny this stacking

Same action as double click.

Allow this stacking

Same action as double click.

Set conjugate rule

Assigns the same rule to the configuration
rotated by 90.

Deny shown stacking

Excludes stacking between the two items (all
positions).

Allow shown stacking

Allows stacking between the two items (all positions).

Clear shown exceptions

Delete all exceptions for the shown packages.

Delete ALL exceptions

Delete all exceptions. The action cannot be undone.

At the top of the panel, there is a tool menu with the following commands:
Command

Description

Tools

Opens a the contextual menu.

Active

Shows the Stack Matrix

Close

Closes the dialog.
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Stack Matrix Dialogs
The Stack Panel is displayed as a dialog window when called up by the command
Stack

of the Constraint Panel;

Stack

of the Package Manager.

The functions are identical to those described in the Stack Panel section.
In this particular display mode, the tree control on the left (bottom package) only
lists the package in question. The Tools menu features a filter that can be used to
quickly select the upper package. In the case of opening from Database, there will
be two surfing pushbuttons, and the exceptions will apply to the retained records.

Set Load Dialog
The dialog is employed to enforce the Set
Load set constraint. You can open it by
using the command Tools → Open Group
Dialog
, or by double-click on a cell set
of the List grid.
To form a group:
1) input the name in the text box New group
and press the button +;
2) select the items in the list to the right
(hold the button Ctrl down for multiple
selections);
3) drag the selection on the name that appears in panel on the left.
To delete a group, or part of a group, use the contextual menu, opened by clicking
the right mouse button. The menu also contains commands to expand or collapse
the tree-list on the left. A button allows to choose the color for the group.

Error on Constraints
In case of inconsistency of the input list, the program stops the execution of the
optimization and displays a special information window. Typical errors are:
– setting the center-of-mass control with some type of package with no assigned
weight;
– mc index higher than the number of containers;
– starting solution inconsistent with the set or bat constraints.
In the following cases, the dialog instead allows the User to take steps in order to
solve the problem.

Package Dimensions
The error window is activated when the dimensions of certain packages exceed the
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dimensions of the containers. The dialog shows four self-explanatory options

Set qty=0 for this item
Remove the item from
the input list
Leave the input list unchanged
Stop the optimization
run

Batch Load
The dialog is used to correct the input data whenever the input quantity qty is
inconsistent with the batch parameter bat. You can select one of the following
intuitive options

Drop the packages in
excess from load plan
Treat remaining packages
as new batch
Keep remaining packages
as individual items
Cancel the optimization
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Solvers
packVol can operate in two distinct modes, automatic and manual. The choice is
made by selecting the appropriate tab in Panel Solver on the top left corner. When
you select the Message tab the command to start the calculation is disabled.

In automatic mode the load plan is evaluated by the internal optimizer of the
program, whereas in manual mode the load plan is created or modified by the User,
thanks to a 3D graphical environment having the most common editing functions.

Automatic Solver
To start the automatic optimization select
the tab Automatic and then click on the
command Tool → Start Evaluation in the
menu bar
. Once started the run,
a small window is displayed on top of
the main window, which carries a timer,
showing the elapsed time, and a button,
which allows you to stop the calculation.
This window also freezes any interaction with the main application window.
During the evaluation, the Solver panel
is set on the Messages tab, which displays short messages about the optimization
status. The best solutions are visualized on the visualization area as soon as they
are found by the program.

Run options
Option

Description

Max execution
time (s)

Maximum execution time in seconds. If the solution has more
than one container, or if the setting Auto-Add Container(s) is active, the execution time refers to each container. The program
can alter the execution time if needed.

Random Start

The optimization begins from a random choice. This allows you
exploration of diﬀerent possible solutions.

volume
weight

The volumetric occupancy of the container is optimized (predefined option) or the weight loaded into the container.
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Option

Stop
Continue
Improve for

Description

The group of options establishes the behavior in case the solver is able to complete the load. In addition to maximizing the
optimization parameter, the program also seeks to stow the load
in the “most compact” way. Therefore it may be useful leave
the program running also when it finds an optimal solution.

Destinations
Shows a schematic summary of the current settings entered in
Advanced Sett- the Destinations Dialog. The Edit
command allows to open
ings
it in order to change the parameters.

Manual Solver
In manual mode the load sequence is
defined by the User. To start the work
session select the tab Manual in the Solver Panel and then click on the command
Tool → Start Evaluation in the menu bar
. The panel, besides a brief note on
the features of the mode, contains two
check boxes which should be checked, if
necessary, before you start.

Run options
Option

Description

Don’t fix package Starts the session without assigning the number of packages,
qty in advance which can then be placed at will.
Define a containerStarts a session where you can define a container with unusable
with unusable unusable spaces.
spaces

Work Environment
The work environment is formed by the toolbox and the package list, on the left,
and by the visualization area, which acquires interactive capabilities in response to
the mouse input. The toolbox contains the usual editing functions of a graphics application (see table). Most tools have an associated shortcut key(see table), which
allows to operate directly from the keyboard.
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Tools
Undo last operation
[Ctrl+Z]

Redo last operation
[Ctrl+Y]

Select all packages
Ctrl+A

Select by region

Insert package
[SPACE]

Rotate package
[R]

Copy selected packages
[Ctrl+C]

Paste selected packages
[Ctrl+V]

Cut selected packages
[Ctrl+X]

Close working session

Zoom in/out control points

Add New control point

Drag objects

During the manual session a new container can be added to the solution at any time.
Simply, open the Container Manager and select it among those registered in the database. To restrict the working area to a single container, use the pull down in the Auxiliary
Toolbar.
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Operating mode
packVol is an optimization program, not a computer graphics application and the operations that you can perform may diﬀer substantially. For example, paste of packages
takes place only for those objects that satisfy all constraints and can be repeated only
up to the complete loading of a selected item (unless Don’t fix package qty in advance
or Define a container with unusable spaces is active).

Choosing a package
The package to be placed is selected by clicking on
the line displayed in the read-only list on the left.
Selection can be performed if there are packages
of this type yet to be loaded. After selection, the
package code is shown, with the same background
color that you find in the list, right to the code
label. Near the code label it is also reported the
number of packages of the selected type yet to
be loaded (in figure, 29). In the visualization area
the package is drawn with a green wire frame, and
positioned in the first insertion point.

Displaying columns
The list of packages can be displayed using the
item code (code) or size (dims).

Positioning the package
Packages can be positioned only at points predetermined by the program, called
“insertion points”, displayed as small yellow cubes and generated by the program
itself. The point in which to insert the package is chosen by clicking on it with the
mouse, and after selection is shown in red color. The dimension of these cubes can
be modified using the Zoom in
and Zoom out
tools.
Custom Points
If you have need to place a package in a particular location, not provided by program,
you can act in two ways:
a) insert the coordinates of the insertion point L, W and H in the spin controls and
click on the tool

Ins.., b) enter the dragging mode, discussed below.
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Rotation
The package can be rotated using the tool

Rotate [R].

Insertion
To load a package press the tool
Insert [SPACE].
After insertion, the package is drawn with solid
shape. At the same time the program generates
new insertion points. Whenever the package cannot be placed, the wire frame acquires a red color
and the insertion button get disabled. A short
message displayed in the right pane of the status bar and in the view of the load
indicates the reason that prevents the insertion.
After insertion of a package the program automatically tries to load a package of same
type of the last inserted. If these are all loaded, the program chooses the first not loaded
package according to the numbering of items in the list. The program also tries, whenever
possible, to place a package in a valid position, fulfilling all imposed constraints. In the
Advanced tab of the Preferences dialog you can choose if the new package should be
placed at lowest possible level (layer packing), or on top of rear columns (wall packing),
or in a position as determined by the program itself.

Selection
There are two ways to perform the selection, depending on whether the tool
by region is activated or not.
Status

Select

Action

Inactive

Selection is done object by object by clicking with the mouse. A
second click on a selected package deselects the object.

Active

Selection is performed by “region”. By clicking on two diﬀerent
packages, you select all objects belonging to the ideal rectangle
having these two as opposite vertexes. This functionality is very
useful because it allows selection of objects not, or only partially,
displayed. Selected packages acquire a light gray color.

The tool
Select All [Ctrl+A]selects all packages. Press the tool twice to cancel a
selection, or hit the background of the stage area.
Edit
The editing operations
Cut [Ctrl+X],
Copy [Ctrl+C], and
Paste [Ctrl+V]
are enabled after making a selection of packages. The selected objects are displayed
by in light gray. After a copy or cut operation all packages entering the selection
Paste all packages
are drawn with a yellow wire frame. By clicking the tool
are inserted, starting from the insertion point, if they respect all the imposed con-
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straints.

Dragging mode
The tool
Drag objects is active only in case one container is displayed on the work
area. The load view is set on quadruple, and the load is displayed with “objects”
formed by columns of identical packages. By holding the mouse on an object and
then dragging it around, you can move the object in an arbitrary position. The
non-intermingling of objects is the only control operated by the program. The functionality is useful, for example, if you have a few elongated packages and you want
to place them accurately, to have a perfect control of the center of mass.

Settings
The group contains the following tools:
Option

Action

Disable all rules

Neglects all imposed constraints, except the collision between packages.

Disable Selection

Disables selections, so that no packages can be copied,
pasted or dropped.

Hide Selection

Suppresses the wire-frame displaying the packages that are
copied or cut. This functionality is useful when moving
groups of packages (“cut–and–paste”) because it immediately shows the position where they are stowed, but may
be annoying if one is interested only in cut operation.
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Option

Action

Block Current View Disables rotation of the load view.
More points

Usually the program generates only one point for usable
space. The option generates points for all individual
packages.

Only Vertex Points

Avoids the creation of points that are not on the top of the
package.

Disable
User Point

Disables definition of additional insertion points and, at the
same time, hides the cross-hair cursor associated to the currently active insertion point.

Modify Solution
In packVol automatic and manual mode are integrated. User may, for example,
position some specific packages in manual mode and then let the program to automatically position the others. Or, User can start a manual session from an automatic solution to manually modify the position of some packages.
To start the modification of a solution, the menu command Settings → Start from
Current
is used.
If the setting is active, all cells in the Package tabs become read-only, with exclusion
of the qty cells of the Dimen. tab and of the description fields. The program forces
the User to input values for qty greater or equal to those currently loaded. It’s
possible to add containers without altering the state of a verified solution.
Once a solution has been obtained, you can increase the number of packages to be
loaded by keeping the same position of the packages of the current solution. The
added packages are thus positioned in the free space available in the current solution. In automatic mode, the setting thus allows you to increase the number of
packages to be loaded, positioning the added ones in the free space available in the
solution. In manual mode, the option allows you to change the load plan by using
visual tools.
Please pay particular attention that, when the command is selected, the solution is
registered and conserved up to the subsequent deselection of the command. Hence,
all optimization sessions, both automatic and manual, always start from the registered
configuration.

The manual modification is the most common operation. For this reason the
program includes the command Tools → Modify Solution, which allows you to start
the manual modification of the solution without having to worry about the state of
the command Start from Current. The command features two options: Keep fixed
item qty, used by the program to check that the number of loaded packages does
not exceed the number entered in the qty field and the option Don’t fix item qty
Number of Packages Free, which instead places no limits to the possibility of load-
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ing packages. At the end of the work session, the program asks whether or not to
confirm the changes made.

Re-optimize Solution
One of the possible ways in which the program can be used is to calculate the number of containers needed to completely load the input list. Sometimes it may happen
that the last containers have volumetric eﬃciencies which are very low compared to
the first containers. The number of containers used being equal, it is often instead
preferable to have a homogeneous distribution of the load among the used containers. The command Tools → Redistribute Load meets this need. If called up, the
program redoes the calculation starting from the solution obtained and searching
for the most homogeneous distribution possible.
The command tool
Re-optimize the Output tab meets the same need, however
it allows you to choose which containers to re-optimize. This function can be useful
when optimizing by weight. The complete saturation of the maximum weight often
corresponds to low volumetric eﬃciency. Re-optimizing makes it possible to easily
explore diﬀerent load configurations, letting the User choose the most suitable one.
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Analysis Tools
In addition to tools used to create the load plan documentation, the Report menu
also contains a few tools for analyzing the solution. The commands are activated
at the end of the calculation, automatic and manual.

Summary Report
The tool Report → View Report
activates a window which replaces the load
plan view. The new view displays a summary about essential data of the optimization session. The summary can be printed
or saved in html format for later use and/or
integration with other documents. To print
or save use the standard commands in the
File menu. The commands are active only
when this window is open. An auxiliary toolbar allows to perform the same operations.
The report is intended primarily for use on video. For saving optimization data see
section Data Export.

The panel contains a toolbar with the following additional functions:
Command

Description

Expand

Minimizes the left panels

Print

Prints the summary report

Preview

Start the standard Print preview dialog

Save

Saves the summary report in html format

Close

Closes the panel

Measurements
packVol oﬀers two measuring tools that are activated, in case the solution entails
multiple containers, if just one container is properly displayed.

Load Distribution
To visualize the longitudinal weight distribution, select the menu command Tool →
Weight / Density
. The visualization area shows a lateral view of the container.
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To define the section to be studied, hold the left mouse button on one of the two
red triangular indicators and move the mouse. The section is given by the volume
inside the two indicators. The program displays immediately a brief summary on
linear dimension, volume, loaded weight, and density of the section.

View of Empty Spaces
The tool Report → Measurements → View Empty Spaces allows you to visualize the
empty spaces. To display a space
•
•
•
•

Move the mouse over the placeholders. Information are shown on top of screen.
Double-click on a placeholder to freeze the view of an empty space.
Double click again to restore selection mode
Use the “min Dim.” text box to control the spaces to visualize.
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Database and Network
packVol stores data of packages and containers in an internal database and employs
the definitions as a way to simplify data entry operations in the Package Panel and
Container Panel.
The application also allows the acquisition and storage of data from any external
database that supports ODBC protocol. The application has been tested on many
systems: Sqlite, Microsoft Access, MySql, Microsoft Sql Server, AS400/DB2, Oracle
g. Please refer to the section ODBC Data Exchange for details.
The internal Database is not needed for proper program operation, and its use is optional.
The application does not automatically store information on packages or containers of
the solution, but instead stores them in the internal Database only if and when requested
by the User. The use of the ODBC support is also optional. This last function is not
included in the LITE version.

Internal Database
Data are physically stored in the file packVol.sqlx of the installation folder for Windows 2000/XP (usually C:\Program Files\packVol), or in the application data folder for Windows Vista/7/8 (usually C:\ProgramData).If the file is lost or damaged, a fresh copy can be found in the sub-folder packRescue of the installation folder (usually C:\Program Files\packVol for Windows 2000/XP, C:\Program
Files(x86)\packVol for Windows Vista/7/8).
By default, the folder C:\ProgramData is hidden. To display it, change the folder
display settings or enter the address C:\ProgramData\packVol in the address bar of
Windows Explorer.

Data Insert
You can populate the packages Database by either saving the “solution data” or
through an automatic “import”. The container data, however, cannot be imported
automatically. For the containers, once you have entered the data in the Current
Tab of the Containers Panel (manually or by importing it) use the save tool available
in the tab.
The database manager does not allow duplication of the field code (packages) and
name (containers), helping you resolve name collision with appropriate dialogs. During
the automatic import, records with a duplicated code field are eliminated.
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Saving item rows
The rows selected in the Packages Data Panel can be permanently stored in the
Database using the menu command Database → Save Items in Database
, or the
equivalent command Add rows to database of the contextual menu of the Dimen.
grid.
If the Load by Objects is enabled, instead of the Save Items in Database tool it
is preferable to use the contextual menu of the Dimen. grid in order to distinguish
between box or plt packages. The default type is box.

Import Database
Package data can be imported by means of ODBC connection or from Excel files
using the commands Database → Import / Update Database.
→ Data from Excel
The format of the Excel file is identical to the file used to import the loading list.
Column A, number of units, and I, destinations are not used.
→ Data via ODBC
The ODBC tables used are pv sku, pv cnt and pv obs. All rows present are imported, regardless of the value of selection index g job. In this case as well, fields that
refer to a number of objects or destinations are not used.
Importing data entails the elimination of all existing data and the writing of new data.
Prior to this operation, the program saves the current database in the backup file
packVol.sqlx.SAVE. This operation cannot be undone. In case you need to restore
the old data, delete the file packVol.sqlx and rename the backup file using that same
name.

Retrieval
The window is employed to transfer the package definitions into the Package Panel
grids, and is activated via the menu command Database → Open Package Managers
→ Data Retrieval
, or by using the command Add Package(s) from DB of the
Dimen. grid.
Once opened, the Manager window takes the place of the load view, and shows in
tabular form all database records. The records can be sorted by clicking on the field
labels, which reproduce that of the Package tabs. There is also the additional field
volume, automatically evaluated by the program and displayed for reference and for
ordering purposes.
To load the data, select the desired rows and click on the Load
use the contextual menu as shown in the figure.

pushbutton, or
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The window contains an additional toolbar having the following tools:
Command

Description

Load

Appends the selected records to the package grids.

Clear

Clears the current selection.

Type

Displays a menu with which you can isolate records having a
stack matrix rule. If the “load by objects” is active, the menu
also allows to show only packages of type box and/or type plt.

Back

Displays the previous records.

Next

Displays the next records.

Filter

Displays a menu where you can filter the records according to
code or to description. The input string should follow the usual
SQL syntax, with % as the wild card character.

Close

Closes the window.

The two commands allow you to browse the records. The database can easily store
thousands of records, however the manager limits the visualization to one hundred
rows at a time.
If in the Preferences dialog the option Protect data loaded from database or from
excel is selected, all data inserted into the Package Tabs are set as read-only. Use

packVol 3.7.0 - User Guide - 69

the command Setting → Cancel read-only status to allow manual modification of the
data.
Retrieval by code
If you enter the code of a record present in
the internal database, as soon as the cursor
changes position the definitions of the item are
automatically retrieved from the database and
transferred to the Package Panel. At this point
you need just to enter the number of packages. This function allows you to quickly
create the load list, without the need to open the Package Manager.

Maintenance
The window is used to insert / modify / delete records of the database and is activated by means of the menu command Database → Open Package Managers → DB
Maintenance
.

The auxiliary toolbar on top of the list of records have essentially the same tools of
the Data Retrieval manager.
Only diﬀerence:
the tool
records.

Delete takes the place of the tool

Load and allows to delete the selected

Below the record list a set of suitable input boxes allow insertion of a new record or
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the update of an existing one. The following list shows association with the fields
of the Package Panel tabs.
• code, length, width, height: fields of the Dimen. tab;
• desc: field of the Desc. tab;
• set: field of the Box tab. In the database interface you enter an alphanumeric label. The application rebuilds the set by collecting all items
with the same label. Ratios are automatically calculated given the input
quantities.
• weight, batch: fields of the Box tab.
• qt/b: field of the Box tab, enabled if the “Load by Objects” is active.
The field hb is active only for packages of type plt.
Above the group of textboxes there is a second toolbar with the following functions:
Command

Description

Color

Assigns the color of the package.

Space

Shows the Spacing constraints Panel.

Stack

Opens the Stack Matrix dialog. The dialog, besides all functions of the standard Stack Matrix dialog, has two additional
browsing buttons for navigating through records on the database.

Insert

Inserts a new item into the database.

Update

updates data of a record. All the fields can be changed except
the code.

New

Deletes all data entered in text boxes.

To set the remaining constraints of the List, Pos, Handl. and Space tabs, the Manager includes a specialized version of Constraint Panel. Please refer to this section
for details. The panel includes a grid which reports the numerical value of the
imposed constraints. Cells of this grid can be edited as a shortcut option.

Container Manager
To transfer in the Containers Panel the definitions of the containers stored Database, you need to open the Containers Manager by means of the command Database
. This tool can also be found in the Input Tab of
→ Open Containers Manager
the Containers Panel.
The dialog shows all registered containers. You can select a container by clicking
on a row of the grid list. When the dialog is active, the visualization area displays
a preview of the selected container.
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All records are read-only. Data should be inserted by means of the tool the
Data, found in the Current tab.

Save

Record fields
Column

Description

Name

Container name.

Length

Container length.

Width

Container width.

Height

Container height.

Type

Type of container: Std closed container, Opn open container,
Rck rack container.

Obs.

The value no signals a plain container without unusable spaces.
Otherwise the number shows how many “obstructions” are present inside the container.

Tools:
Command

Description

Cancel

Deselects any active line.

Load

Transfers the container data into the Current tab of the
Container Panel

Delete

Deletes permanently the selected records.

Close

Closes the dialog.
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Configure Database
The database can be configured by means of a dedicated dialog, that you open using
the command Tools → Configure Database
. The dialog is formed by four tabbed
windows, Authentication, General, ODBC, Local DB.
In the Windows Vista/7/8 operating systems, all operations marked with
require administrator privileges. To start the program as administrator, right-click on the
program icon and select the item Run as administrator.

Authentication
If you input and confirm a password ( ), the
access to the database maintenance window
and all operations involving changes to the
data will become password-protected. When
you start the program the first time, authentication is disabled. If you activate a password and you wish to return to the nonauthenticated mode, simply enter an empty
password and press confirm.
Protected operations are:

• management of the internal database, including insertion of new records
via the contextual menu of Dimen. tab;
• updating of the internal Database of data import;
• update/insertion/deletion on container data;
• modification of the ODBC connection start configuration;
• creation of ODBC exchange tables;
• configuration of the generation of automatic reports when saving data;
• change of the read-only status of input data, if this option has been
enabled in the tab General described below.
To perform each of those operations, password
should be entered in the text field of a simple
dialog. Checking the box Remember my credentials for this session, the password will no longer
required for the current work session. In case you
need to restore dialog, check the box Disable autoauthentication and prompt for password again.
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General
The General Tab is used to:
- set the protection options against changes in the
imported data;
- enable additional fields in the Package Panel.
To make the changes operational, click on Confirm
before closing the dialog or changing tab.

Protect data loaded from The data of containers and packages can be modified
Database, Excel or ODBC at any time by editing the appropriate input controls.
When checked, the option prevents modification of
the imported data imported from data sources. This
feature is intended to prevent accidental changes.

The command sets the read-only status for all Users
accessing the program.

Force read-only status
for all users

Require password to unset Read-only status can be eliminated at any time using
read-only status
the command Settings → Cancel read-only status. When
checked, the command can be executed only if User has
administrator privileges.
Enable “load by objects”

Check this option of you need the load by objects functionality.

Enable secondary description field

Displays the optional description in the Description
Grid. The values are used only to format the reports.
The command Edit allows you to configure the properties of
the descriptive secondary field: format (textual or numeric)
and labels.
In the case of a numeric format the total value of the field
is reported in the reports generated by the application.
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ODBC
The tab allows you to configure the connection to
any external database that supports the ODBC
protocol. It consists of three control groups, for the
connection, for the connection start options and for
the creation of exchange tables and saving options.
This single window can also be opened with the
menu command Database → Manage ODBC Connection, which is always available, even in case password protection is enabled.

Datasource

In the text box you enter the name of the Data Source
(DSN).

Username

In the text box you enter the username for connecting,
if necessary.

Password

In the text box you enter the username for connecting,
if necessary.

Connect

Establishes the connection to the Data Source. If the
operation is successful, the button shows the label Disconnect and can be used to disconnect from the data
source.

Set as Default
Data Source

The checkbox allows to register the DSN as the default
and to fill the text boxes with the data required for
connection at start-up.

Connect at Program
Start Up

The checkbox establishes the connection to the data
source at start-up, without need for further intervention by the User.

Create

The button is used to create the exchange tables. See
the section Import via ODBC for details. The operation
should be done the first time only, because it leads to
the deletion of the tables, if they are already present.

Open

Opens the dialog window where you can set up the reports creation when the ODBC data is exported. The
configuration is described in the section Automatic creation.
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Local DB
The fourth panel allows you to operate backup copies of the local database and to force the loading of a
Database from a location other than the predefined
one. This second operation, as described in the
section Sharing the Database, allows the sharing of
a local LAN network among users.

Copy DB

The command allows you to copy the database currently in use,
if available, in a diﬀerent folder.

Assign

The command allows you to assign the database to be used in
the current session and all subsequent openings of the program.

Clear

The command removes the association for the recorded database, and restores loading the database of the original installation.

REGISTERED
Database

The text reports the registered database for loading at the start
or the message No database registered in case of loading of the
predefined database. If the registered database is not accessible,
the message [ERROR] will appear.

WORKING
Database

he text reports the address of the currently loaded database
or the message No database loaded in case of error during the
loading.

Error Management
If for some reason the database is no more accessible, the program displays a dialog
allowing you correct the problem. You can undertake the following actions:
– open the Configure Database dialog to select a
diﬀerent database;
– use the local database present in the installation
folder;
– continue to work without support for the database.
The first two options may require administrator privileges to be accepted. The last
option does not require password.
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Share on LAN
Remote Desktop
The program has been tested for use by Remote Desktop and with Terminal Server
services. It has also been verified to work properly in Linux and Mac OS X with
WINE emulator and with CodeWarrior.

Sharing the Program
In this note we assume the program packVol has been installed in the folder
C:\Program Files\packVol (Windows 2000/XP/Vista/7/8 32 bit),
C:\Program Files(x86)\packVol (Windows Vista/7/8 64 bit),
of the SERVER computer, with computer name \\NAMESERVER. To share the
program follow these steps:
Windows 2000/XP
1) Share the SERVER installation folder C:\Program Files\packVol, say with
name packVol. Please make sure that users have read and write permissions on the shared folder, otherwise the program will generate errors
on all database operations which require write privileges (DELETE,
INSERT, UPDATE).
2) From the CLIENT PC, open Explorer clicking on “My Network Places”
and locate the shared folder (in the address bar should appear the address
\\NAMESERVER\packVol). Open the folder, right-click on the executable packVol.exe and click “Send To Desktop (create shortcut)”.
3) Run packVol by double-clicking on the newly created shortcut.
Windows Vista/7/8

1) Share the installation folder C:\Program Files(x86)\packVol (or C:\Program
Files\packVol) on the SERVER, say with name packVol. Do not alter
any permission.
2) Share the data folder C:\ProgramData\packVol on the SERVER, say with
name packVoData. Please make sure that users have read and write
permissions on the this shared folder, otherwise the program will generate errors on all database operations which require write privileges
(DELETE, INSERT, UPDATE).
3) From the CLIENT PC, open Explorer clicking on “My Network Places”
and locate the shared folder (in the address bar should appear the address
\\NAMESERVER\packVol). Open the folder, right-click on the executable packVol.exe and click “Send To Desktop (create shortcut)”.
4) Run packVol by double-clicking on the newly created shortcut. Attention. If the server is Vista/7/8, it might happen that, after an update,
the program requires conversion of the database. In this case, press NO.
5) Run the program and open the Configure Database dialog (Tools → Configure Database → Local DB). Click on the button Assign and locate the
data folder packVolData on the SERVER. Select the file packVol.sqlx and
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press OK. You may now answer Yes if the program requires database
conversion.
If you open the database, (Tools → Open Package Manager → Data Retrieval), the
Database: label will report the path \\NAMESERVER\packVol\packVol.sqlx (Windows 2000/XP) or \NAMESERVER\packVolData\packVol.sqlx (Windows Vista/7/8).

Sharing only the database
packVol can be installed on a local folder of a client PC but can be configured to
use a network shared database. We consider the case where you have installed the
program on various PCs.
To share the database follow these steps:
1) Run the program from any PC and open the Configure Database dialog
(Database → Configure database → Local DB). Press the button Copy and
copy the database on a shared folder at your choice. A standard dialog
will help you locate the folder or to create a new folder. The folder must
have read and write permissions.
2) Click on the button Assign, locate the previous shared folder and select
the file packVol.sqlx.
3) Repeat the previous step 2) from all other installations.

ODBC Data Exchange
The program can retrieve package and container data from any external database
with support for the ODBC protocol. As an example of how to set up the feature
we consider the case Microsoft Access. After creating a blank database, open the
ODBC Data Sources control panel (Start → Administrative Tools → Data Sources
(ODBC)). Press the button Add and click MS Access Driver. Enter a name for the
DSN, say pvDATA, and select the file you have just created.
On Windows Vista/7/8 64 bit, in order to properly register the data origin it may be
necessary to open the 32-bit DSN management program.

Once packVol has started, please open the configuration dialog using the command
Tools → Configure Database
, choose the Configure ODBC tab and establish the
connection.
After the connection is established, click on Create to create the exchange tables. At
this point you can populate the Access Database following the format of the tables.
In particular, populate the table pv job, assigning a positive progressive value to
the ID primary key and setting g status equal to zero
The installation folder contains an MS Access database called pvDLL.mdb that can be
used for testing purposes. The database contains data of a real example that can thus
be taken as reference.
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Jobs List
The application uses the table pv job as a list of possible load plans (or “jobs”) to
be optimized. In this way, the program can be used concurrently by diﬀerent users
or workstations. Through the menu command Database → Manage ODBC Import, a
dialog window opens that displays the list of jobs registered in the external Database,
with fields that faithfully reproduce those contained in the table pv job.

The rows are colored according to the following Color key
status

color

description

assigned

green

job already imported but yet to be optimized.

imported

orange

job currently imported.

completed

red

job set in the completed state (automatically set in case
of export).

available

white

job never imported.

The Operations button (or the contextual menu) allows you to
1) mark a job as completed even without the export;
2) restore the previous state (from completed to assigned or from assigned to
available);
3) permanently delete the job data (only if the state is completed) from the
exchange tables.
In case the file is saved, the information on the imported job is retained. You can mark a
job as completed only if said job is currently loaded (in other words, only an “orange” row
can be marked as “red”). Data can be loaded through ODBC or through the opening of
a file that was previously saved. The program does not check whether the optimization
has been carried out and/or if the pdf report has been generated.
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Data Import
Import Data from Excel
Package data can be imported from an Excel file in native file format xls (Excel
97/2000/XP) or xlsx (Excel 2007/2010).Import commands can be found in the menu
File.
Command

Description

Import (Excel) → Import Master Data
[Ctrl+Shift+M]

Import the whole package definition from the Excel file.
For details, please refer to the section Import Master
Data.

Import (Excel) → Import Code/Qty

Imports data in the Data Tabs using the information
contained in the internal Database. For details, please
refer to the section Import Code/Qty.

Import Container

Imports the types of containers to be used during the
optimization. For details, please refer to the section
Import Containers.
When the two commands Import Master Data and Import Code/Qty are
used, prior to opening the Excel file
a window is displayed that allows
you to quickly check the correctness of the data to be imported and
to choose the random assignment of
package colors.

Import Master Data
The command File → Import (Excel) → Import Master Data [Ctrl+Shift+M] imports
in the data tabs the full definitions of the package types.

The format of the Excel file, with or without header row at your choice, is described
in the following table.
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From version 3.0.0, so as to not having to distinguish between input e output Excel files,
the program acquires data only from the first sheet of the Excel file. Any subsequent
sheets are ignored.

col.

type

A

integer

B

description

value

tab

number of packages

integer ≥ 0

Dim.

integer

package length

integer > 0

Dim.

C

integer

package width

integer > 0

Dim.

D

integer

package height

integer > 0

Dim.

E

text

alphanumeric code (primary key in the case
of import into internal database)

text

Dim.

F

integer

number of “objects” per package

integer > 0,
[1,default]

Box

G

float

package weight

float ≥ 0 [0,
default]

Box

H
I

text
integer
/ text

description
destination index or name; the zero value
or the empty cell excludes the constraint

text
[0,default]

Desc.
List

J

integer

[1-63], [3,default]

Pos.

K

integer

allowed positions; for empty cell the value
is taken from the default as set in the
Preferences
floor only; the zero value or the empty cell
excludes the constraint

[0-63], [0,default]

Pos.

L

integer

top-only; the zero value or the empty cell
excludes the constraint

[0-63], [0,default]

Pos.

M

integer

not at floor; the zero value or the empty
cell excludes the constraint

[0-63], [0,default]

Pos.

N

integer

integer ≥ 0,
[0,default]

Pos.

O

integer

integer ≥ 0,
[0,default]

List

P

float

Q

integer

max stacking; the zero value or the empty
cell excludes the constraint. The value is
global and applies to all sides
stack index; the zero value or the empty
cell excludes the constraint. The value is
global and applies to all sides
max bearing weight; the zero value or the
empty cell excludes the constraint. The
value is global and applies to all sides
minimum number; the zero value or the
empty cell excludes the constraint

float ≥ 0, [0,def- Pos.
ault]
integer ≥ 0,
[0,default]

List
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col.

type

description

value

tab

R

integer

batch; the zero value or the empty cell
excludes the constraint

integer ≥ 0,
[0,default]

Box

S

text

set load. The items forming a set must
have the same label. During the import
process, the application rebuilds the set
and defines the ratio according to the number of packages g total of each item (cell
A).

[’ ’,default]

Box

T

integer

matching code; the zero value or the empty
cell excludes the constraint

integer ≥ 0,
[0,default]

List

U

integer

forklift handling

[0-63], [0,default]

Handl.

V

integer

columnar order

[0-7], [0,default] Handl.

W

integer

[-1,default]

Handl.

X

integer

max overhang; the zero value or the empty
cell excludes the constraint
empty space, length side

[0,default]

Space

Y

integer

empty space, width side

[0,default]

Space

Z

integer

empty space, height side (spH ≥ 0) or absolute reference (spH < 0)

[0,default]

Space

AA

integer

max height; the zero value or the empty
cell excludes the constraint

integer ≥ 0,
[0,default]

Pos.

AB

integer

[-1,default]

Desc.

AC
AD

text
integer

text
[0,default]

Desc.

AE
AF

text
integer

package color (black=0, white=255255255);
a negative value or the empty cell assigns
a random color
optional description
type box [0] or base height for type plt if
>0
reserved
max depth

[-1,default]

The installation does not provide sample files as creating a template is a simple process.
Open the program, Click on File → Export (Excel). A file is created with complete
headers that can be used to create the file to be imported.

If the file is generated by the export of the database, the AK - BI columns have additional
data. These fields are not intended for editing.
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Import Code/Qty
The command File → Import (Excel) → Import Code/Qty [Ctrl+Shift+Q]allows you
to create the load list with minimum eﬀort from the data stored in the database.
In Excel file you can define only two columns: the first (A) with the package code
as stored in the database, the second (B) with the number of packages. Optionally,
you can also set the values that are not stored in the internal Database.
col.

type

description

value

tab

A
B

text
integer

code as stored in the internal database.
number of packages

integer ≥ 0

Dim.
Dim.

C

integer

destination

integer ≥ 0

List

D

integer

minimum number

integer ≥ 0

Box

E

integer

integer ≥ 0

List

F

integer

stack index. The value is global and applies
to all sides
container “matching code”

integer ≥ 0

List

While reading the file, the program selects in the Database the record with the code
assigned in column A. If the record exists, the program retrieves the data and sets
the quantity as assigned in column B.

Import Containers
The command File → Import Container allows to import the container geometry. In
the Excel file format you can define both the dimensions of the container, and of
the possible unusable spaces.
col.

type

description

value

A

text

row identifier, container [cnt] or unusable space
[rect, bbox]

[cnt, rect, bbox]

B
C
D

integer
integer
integer

length “low” coordinate
width “low” coordinate
height “low” coordinate

integer ≥ 0
integer ≥ 0
integer ≥ 0
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col.

type

description

value

E

integer

length [cnt,rect]
or “high” length coordinate [bbox]

integer > 0

F

integer

width [cnt,rect]
or “high” width coordinate [bbox]

integer > 0

G

integer

height [cnt,rect]
or “high” height coordinate [bbox]

integer > 0

H

text

container name (only for [cnt] rows)

text

I

float

max load (only for [cnt] rows)

float

J

integer

default max overhang parameter (only for [cnt]
rows)

integer [0-49]

K

integer

preferred loading sequence, rear-front [0], bottomtop [1], layer-front [2] (only for [cnt] rows)

integer

L

integer

number of containers.

integer

Column A must bear the row label. Possible values are:
value

description

cnt

Container row. Columns B, C, D should be set to zero. In columns E, F, G you enter the internal dimensions of the container.

rect

Unusable space row. Columns B, C, D are the “low” coordinates, E, F, G are the edges.

bbox

Unusable space row. Columns B, C, D are the “low” coordinates, E, F, G are the “high” coordinates.

The rear of the container is assumed near the origin of the axes. Please take this convention into account when defining a container with unusable spaces.

Example
A

B

C

D

cnt
rect

0
0

0
0

0
0

E

1372
384

F

G

249
249

297
35
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Import via ODBC
In order to use the function, a data origin should
be registered, configured and populated as described
in the section ODBC Data Exchange. To import,
click on the menu command File → Import (ODBC)
[Ctrl+Shift+O] and select the desired job in the Jobs
list dialog window. This dialogue is the same as the
one described in the Jobs List section, but with disabled management functions.

Clipboard
You can “Copy to” / “Paste from” the Clipboard the most important fields of the
Package Panel, in order: qty, l, w, h, code, wt., ps, ds.
You can also “paste from” the system Clipboard such data as quick way to set up
the load list.
Finally, you can use copy and paste to apply the loading by Code/Quantity. Just
paste the data of two columns, the first containing the code and the second the
quantity. In this case, the code should refer to a record registered in the Database.
The program automatically loads the data based on the number of columns and the
format of the pasted data. In packVol the combinations [Ctrl+C] and [Ctrl+V] are
reserved to the cut/paste of the rows in the Data Tabs.

Copy
To copy data from the program and paste it into an external application
1) in any of the Data Panel grids, select the lines you need to copy;
2) click on File → Copy to Clipboard [Ctrl+Shift+C], or select the Dimen. grid
and use the contextual menu;
3) paste in the external application (usually with the key combination [Ctrl+V])

Paste
To copy data from an external application and paste it into the program
1) from the external program, create the table of data, writing in order the values
qty, l, w, h, code, wt., ps, ds. In case you are using a text editor, e.g. Notepad,
or a word processor, e.g. MS Word, all strings must be separated using the tab
character (key Tab). Copy the data in the external program (usually with the
combination [Ctrl+C]);
2) again in the external program, copy the data (usually with the combination
[Ctrl+C]);
3) from packVol click on File → Paste from Clipboard [Ctrl+Shift+V]. If you
select the Dimen. tab, you may also use the contextual menu .
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Reports and Saving data
Saving on File
The work session can be saved at any time in a file, with extension 3dp, by means
of two commands File → Save
and File → Save as... In addition to these two
standard commands, the program oﬀers some special tools for saving on files
Command

Description

File→ Save Partial Data →
Save Loaded Packages

Saves the list of loaded packages and the
containers used in the current solution, thus
redefining the load list.

File→ Save Partial Data →
Save Unloaded Packages

Saves the list of packages that were not loaded.
The new file can thus be reopened in order to
proceed to optimize the rest. The saved file
does not list the containers.

File→ Save Partial Data →
Save Selected Rows

Saves in a file only the selected rows in the data
sheet. The saved file does not list the containers.

Save Partial Plan

Saves in a file the optimization data of the
containers selected in the Output Tab.

Save Summary Report
The Summary report (see section) is mainly meant to be displayed in a video. It can
nevertheless be saved in the html format, using the command File → Save Summary.

Load plan in pdf format
packVol generates documentation on the load plan in pdf format, with automatic
procedures, started by the User or by the program itself, or with a manual procedure, with which the User can change in real time all the report format settings.
The start commands are found in the menu Report → Load Plan in pdf format, and
are enabled for optimized solutions only. Please contact us at www.packvol.com
for ways in which to customize the various reports.
Please note that if the file that you want to save is in use by another program, such as
Adobe Reader, saving the file may fail. When creating the pdf file a dialog freezes any
input. The operation cannot be interrupted.

Document formatting
There are many ways in which you can format the documentation; here below are
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the main formatting parameters that can be selected.
List Options
Unique Code

The program allows the code to be duplicated in the load
list. The option forces the program to group together types
with identical code into a single actual type, recalculating
the totals in the output list.

Summary List

When selected, in addition to the load list for each
container, the program generates a summary list with the
allocation of packages between the various containers of the
solution.

Layout
The Layout sets the type and number of views to be generated. The layouts can
be static, with a fixed number of views, planar, simple, level and layer, or dynamic,
with a variable number of views, single, duo and quad. For dynamic layouts, the
number of views is controlled in the set of options Load Instructions/Number of
Views.
planar layout [static]
A single view from above is generated,
with progressive numbering of the stacked
packages. The layout shows the summary
view and the load distribution. The load
list is shown in the pages below.

simple layout [static]
Two summary views are generated from
opposite angles. The layout has no other
graph elements. General information and
load list, if possible, are concentrated on a
single page.
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level layout [static]
Displays a sequence of views from above
formed by horizontal sections. Stacked
identical packages are grouped in columns.

layer layout [static]
Like the previous one, but each layer consists of a single package. Identical stacked
items are not grouped.

single view [dynamic]
The program displays a sequence of partial views, with each view showing a section
of the load displayed from only one angle.
Figure shows the document with the loading instructions.

duo view [dynamic]
The same sequence of views of the single
layout is shown from two opposite angles.
The figure illustrates the document with
the option “view by sections”.

quad view [dynamic]
The same sequence of views of the single
layout is shown from four opposite angles.
The figure shows the print option without
positioning instructions.
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The group displays also other drawing options
drawing style

color and text

The package is rendered with color and displays item code.

text only

The package is rendered with color but doesn’t display item
code.

color only

The package displays item code but is rendered in gray.

blank style

The package is rendered in gray and doesn’t display item code.

Single box label

For drawing clarity, the code is associated, where possible, with
blocks of identical packages. This option forces displaying of
the code on every package.

Plan on new page If the option is selected, the sequence of views begins on a new
page, otherwise begins immediately after the load list.

Loading Instructions / Number of Views
The group is active only for dynamic layouts and allows you to control the number of
views and their presentation. The most important option is Simple view by sections
of the load. When the option is checked, the group displays only two active controls
Simple view by sections of the
load [active]

The views are drawn by splitting the load in
longitudinal sections.

Nr of view sections

Here you enter the number of sections, from
one (equivalent to the simple layout) up to a
maximum number determined by the program.

When Simple view by sections of the load is inactive, the views are created by displaying a sequence of blocks of identical packages, in order to have an eﬀective
description of the sequence of positioning of the load. In this case, the group of
controls provides a greater number of options.
Nr of steps per
view

Number of blocks to be included in the same view. Varies from
one to four.

block size

The combobox is used to set the size of the blocks. Options are
small, medium and large.

Print loading in- If selected, for each block the document reports a summary of
structions
weight and volume of the block, orientation of the package, position and extent of the block.
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block size is a useful parameter only when the load plan is formed by a small number
of diﬀerent items but large number of packages. In this case, it may happen that the
load plan is formed by a small number of large blocks. The user can choose whether to
display them in full, or to use small blocks in order to comply with the positioning of the
load sequence.

Sequence order
The group is enabled only for dynamic layouts and makes it possible to choose the
order of the views, regardless of the option selected during the optimization.
Sequence

description

Container Default Sequence The views are shown according to the current choice
of the Load combo-box.
Rear-Front Sequence

The views are shown according to the rear-front
sequence.

Bottom-Top Sequence

The views are shown according to the bottom-top
sequence.

Destinations
The group is active only when you employ the ds parameter.
option

description

Print Destinations

Adds to the report the list of destinations ds. The descriptions are taken from Destination Grid.

Use ds color

The package is rendered with the color assigned to the
destination.

Document Header
The various options let you customize the headings in the document.
option

description

Print manifest header

Prints the two text fields and the date of the document.
The labels of the text fields can be customized in the
Report tab of the Preferences dialog. If data is imported via ODBC, the strings can be imported from the
fields g desc, g rif and g date of pv job table.

With image logo

Prints on the document the Company logo, which can
be customized in the Report tab of the Preferences
dialog.
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option

description

Logo on all pages

When checked, the logo is printed on all pages, otherwise only on the first.

Show page header

Includes the header line with the date of creation.

Show page footer

Includes the footer line with application name and 3dp
filename.

Fixed preferences
Some formatting options are found in the Report tab of the Preferences dialog because they are usually fixed once and for all.

Automatic Export
The command Report → Export Load Plan in pdf format [Ctrl+E]
allows you to
automate creation of the report. Beside the standard groups of controls, the dialog
contains tools to be used in the case of multi-container solutions.

Container Range

Allows to limit the range of containers to be included
into the report.

One file for each container The report is broken into multiple files, one for each
container. The file names are created by adding to the
name chosen by the user a progressive suﬃx.
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Manual procedure
The manual procedure is started with the
command Report → Load Plan in pdf format
, and allows the User
→ Manual creation
to choose in real time the layout and to
acquire partial views of the load as desired
in case of dynamic layout. When it opens, the window takes up all the available
space, with a panel on the left that contains
controls used to define the Layout. The toolbar is replaced by a specialized toolbar.
Underneath the toolbar, there are fields for
the headers and the date. In case of a solution with multiple containers, to start
the creation you need to first of all select the container you are interested in from
the drop-down menu of the Auxiliary Toolbar.
Command

Description

Auto

Automatically generates the report given the current layout
settings.

Back

Removes pictures from the visualization.

Next

Adds pictures from the visualization.

Snap

Creates a partial view (“snapshot”).
added to the report.

The partial views are

The drop-down menu shows the partial views list, which can
be numerous for complex solutions. By selecting a number, all
views up to said number are automatically displayed. This way,
you can quickly create the relation without having to go through
the Next and Back commands.
Cancel

Destroys the snapshots and restarts the procedure.

Save

saves the report in pdf format.

Close

Closes the panel.

How to use
No additional action is necessary for static layouts. For dynamic ones, on the other
hand, the two Next and Back buttons can be used to add / delete partial views
to the view. The Snap command adds the view to the Load Plan document. The
views acquired are listed in summary form under the work view as a reminder. The
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document can be saved at any time.

Export (Excel)
Work data can be exported onto Excel files at any time, using the menu command
File → Export (Excel). The available format is xls or xlsx, as desired. The generated
file contains only one sheet, if non-optimized data is being exported, or multiple
sheets in case of verified solutions.
First sheet
It always contains the input data (please refer to Import Master Data for the format)
so that you do not have to distinguish between input and output file.
Second sheet
It contains information on the load list
col.

A

header

Cont. Nr

description

Container Index, it follows the numbering of the Output Tab.
For all items not loaded, the program uses a fictitious container with
index 0. Cells of these items are rendered with yellow background.

B
C
D
E
F
G
H
I
J
K

ID
Loaded
Total
Length
Width
Height
Weight
Code
Desc.
Qt/b

Item ID. The values follow the numbering of the Package Panel.
Number of items ID loaded into container Cont. Nr.
Quantity of items.
Package length.
Package width.
Package height.
Package weight.
Package code.
Description of the package.
“number of objects”.

Subsequent sheets
A sheet is created for each optimized container that falls within the solution; this
sheet contains
A) summary data of volumetric occupancy and per weight of the container,
B) the load list,
col.

header

A

Cont. Nr

B
C

ID
Loaded

description

Container index, identical for all rows and equal to the number of
the sheet name. The value follows the numbering of the Output
Tab.
Item ID. The values follow the numbering of the Package Panel.
Number of items ID loaded into the container.
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col.

D
E
F
G
H
I

header

Quantity
Length
Width
Height
Weight
Code

description

Quantity of items.
Package length.
Package width.
Package height.
Package weight.
Package Code.

C) a summary image
D) a list of geometric positioning information
col.

A
B
C
D
E
F
G
H

header

ID
pos
vert
vert
vert
side
side
side

L
W
H
L
W
H

description

Item ID. The values follow the numbering of the Package Panel.
position of the item according the the application encoding.
length “low” coordinate.
width “low” coordinate.
height “low” coordinate.
length side.
width side.
height side.

Export (ODBC)
Automatic creation
In the dialog window, opened with the
Open command and of the ODBC Tab
for Database management, you can enable
the automatic generation of report files
during the ODBC export process. First
of all, use the command Change to
choose a Job Folder where the program
should create the files. The program
must have write permission on this folder. The set of options File Creation
contains a list of the various type of files
that can be exported. Check the item to
enable the creation of the corresponding
file. Deselect all the optional boxes if you do not want to use the automatic export.
The file name is assigned by the program by combining the fields of the group Automatic filename format. The boxes g rif and g desc refer to the fields of the table
pv job. It is also possible to combine the current data and the username in the
name. The set of options Error Handling allows you to define the behavior of the
program when the folder is is not accessible.
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ODBC tables
packVol uses the following exchange tables for ODBC import/export operations.
The tables can be automatically created using the Create command in the ODBC
Configuration dialog window of the desktop program or using a special option in
command line version.
Table

use

pv job
pv sku

In/Out
Input

pv cnt

Input

pv obs

Input

pv stack

Input

pv exec

Config

pv report

Config

pv bin

Output

pv geom

Output

pv desk sku

Output

pv desk cnt

Output

pv desk to job

Output

description

The table is used to define the input load list.
Packages
This is the main table where you can define the input list
of items.
Containers
It allows you to define the types of containers to be used.
Unusable spaces
It allows you to define the possible unusable spaces of the
container.
Stack matrix
It is used to define exceptions to the stacking rules between
pairs of packages.
Execution parameters
The table is optional and contains the main execution
parameters for the optimization of the input list.
Report parameters
The table contains the parameters for formatting of the
reports. It is not used in the desktop version.
Container list
Lists the actual containers used in the solution.
Geometry output table
Describes the geometry of the load plan.
Minimal package table
Package auxiliary table, desktop version only.
Minimal container table
Container auxiliary table, desktop version only.
Correspondence table
Desktop version only.

The tables carry many fields, but for a basic usage you only need to enter the few fields
flagged as not null.

Table pv job
The record defines the unique identifier of the input load list.
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The primary key is employed in all other tables to filter the records you want to import
and to assign a unique code to the exported records.

key

ID

description

primary key

type

value

integer not null integer > 0

Zero and negative values are reserved

g desc

description (optional, assigned to the first line of

varchar(255)

text

long text

text

varchar(64)

text

g userID

date (optional, assigned to the date line of the pdf
report). The field is textual and formatting of
the date is free.
user string (optional)

varchar(255)

text

g timestamp
g barcode

last access timestamp
UNUSED

integer
varchar(24)

integer
text

g opt date

UNUSED

varchar(64)

text

g status

status: [0] not assigned, [1] assigned, [2]
completed.

integer

[0, default],
[1], [2]

g sersol

serialized solution (output only)

long text

text

the header in the pdf report)

g rif

optional description (optional, assigned to the
second line of the pdf report)

g date

g date In command line versions, the reserved word AUTO can be used to automatically format date and time in generated reports.
g userID, g status The desktop application checks if the record has g status = 2
(completed work), or g status = 1 (assigned work) but g userID not empty and
g userID ̸= %COMPUTERNAME% (work assigned to another seat). If these conditions are meet, the import process is stopped. Otherwise, the application sets g status
= 1 and stores in g userID the environmental variable %COMPUTERNAME%. You
can configure system to use the environmental variable %USERNAME% instead of
%COMPUTERNAME%. See the Automatic creation dialog.
The command line versions don’t use this filtering mechanism and only set g userID =
%COMPUTERNAME%, g status = 1 for logging purposes. You can avoid updating of
g userID and g status by setting g assign job = 0 in pv exec table.

Table pv sku

The table is employed to enter the packages of the load list.
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key

description

type

value

integer not null

integer > 0

integer not null

integer

varchar(64)

text

integer not null

integer ≥ 0

allowed positions

integer not null
integer not null
integer not null
integer

integer ≥ 0
integer ≥ 0
integer ≥ 0
[1-63], [3,default]

g fl

floor only

integer

[0-63], [0,default]

g nt

top only

integer

[0-63], [0,default]

g nf

not at floor

integer

[0-63], [0,default]

g qtb

number of “objects” per package

integer

integer > 0, [1,default]

g btype

Desktop STANDARD version only. Type
box [0] or base height for type plt if > 0

integer

[0,default]

g dsc

description

varchar(128)

text

g grp

optional description

varchar(64)

text

g wgh

package weight

float

decimal ≥ 0 [0,
default]

g mbe01

max stacking position 1; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

g mbe02

max stacking position 2; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

g mbe04

max stacking position 4; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

g mbe08

max stacking position 8; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

ID

primary key
Zero and negative values are reserved

g job

unique identifier of the input list (reference
to the key pv job.ID)

g code

alphanumeric code (the primary key in the
case of import into internal database)

g total
g
g
g
g

length
width
height
ps

number of packages, or number of objects
if “load by objects” is enforced.
package length
package width
package height
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key

description

type

value

g mbe16

max stacking position 16; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

g mbe32

max stacking position 32; null or zero
value excludes the constraint

integer

integer ≥ 0, [0,default]

g mht01

max height position 1; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mht02

max height position 2; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mht04

max height position 4; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mht08

max height position 8; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mht16

max height position 16; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mht32

max height position 32; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk01

stack index position 1; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk02

stack index position 2; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk04

stack index position 4; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk08

stack index position 8; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk16

stack index position 16; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g stk32

stack index position 32; null or zero value
excludes the constraint

integer

integer ≥ 0, [0,default]

g mxp01

max bearing weight position 1; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]

g mxp02

max bearing weight position 2; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]

g mxp04

max bearing weight position 4; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]

g mxp08

max bearing weight position 8; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]

g mxp16

max bearing weight position 16; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]

g mxp32

max bearing weight position 32; null or
zero value excludes the constraint

float

decimal ≥ 0, [0,default]
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key

g uml
g ump
g lnk

description

UNUSED
UNUSED
group code for set-load. The items form-

type

integer
integer
text

value

[’ ’,default]

ing a set must have the same label. During
the import process, the application rebuilds
the set and defines the ratio according to the
number of packages g total of each item.

g bat

batch value; null or zero value excludes
the constraint

integer

integer ≥ 0, [0,default]

g ds

destination index or name; null or zero
value excludes the constraint
minimum number; null or zero value
excludes the constraint

varchar(128)

[0,default]

integer

integer ≥ 0, [0,default]

package color in exadecimal html format;
null or blank value assigns a random
color
UNUSED
matching code; null or zero value excludes
the constraint

char(6)

[’ ’,default]

integer

[0-63], [0,default]

integer

[0-7], [0,default]

integer

[-1,default]

g lsp

forklift handling; null or zero value excludes
the constraint
columnar order; null or zero value excludes
the constraint
max box overhang; null or a negative
value excludes the constraint
empty space length side

integer

[0,default]

g wsp

empty space width side

integer

[0,default]

g hsp

empty space height side (spH ≥ 0) or absolute reference (spH < 0)

integer

[0,default]

g rfsp
g ﬀsp
g bdepth

UNUSED
UNUSED
max depth; null or a negative value
excludes the constraint

integer
integer
integer

integer ≥ 0

g min
g hexcol

g status
g mc
g tsplt
g clm
g bover

integer
integer

integer ≥ 0, [0,default]

g length, g width, g height In desktop versions, when the three values are zero
and g code is not empty, the program checks against the internal database for the
presence of a record with primary key g code. If it is found, the program takes data
from the internal database and eventually replaces all not null fields of the input
row when set.
Command line versions do not implement this “code - quantity” mechanisms and
the three dimensions must be positive.
g qtb, g btype The fields are employed by the STANDARD desktop version to
implement the “load by objects” function, if enabled. In STANDARD command
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versions “load by objects” is applied whenever g qtb > 1, unless the rule is disabled
in the pv exec.g disable rule field. DYNLOAD versions never use this feature.
g ds The destination is a numerical index that can be defined directly or deduced
from the textual value. In the latter case the numerical order is progressive with
respect to the first occurrence in the load list. In the desktop version you can set
the preferred rule in the Preferences dialog. In command line versions the rule can
be set in the pv exec.g named filo field. In case g named filo is not set the value is
considered as numeric.

Table pv cnt

The table lists the container types. The list of physical containers is created by the
application by sorting the types according to the ID field and sequentially assigning
a number of physical containers equal to g total.
A

A

A

A

A

A

B

B

B

B

1

2

3

4

5

6

7

8

9

10

← value of pv geom.g binID
and of pv bin.ID

Example: if there are two records, (ID=1, g job=1, g total=6, g name=’A’) and
(ID=2, g job=1, g total=4, g name=’B’), the application creates a list of ten
containers numbered starting from 1.
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key

ID

description

integer primary key

type

value

integer not integer
null

g job
g name

unique identifier of the input list (reference

integer not integer

to the key pv job.ID)

null

container name (primary key in the case of

varchar(64)text

import into internal database)

number of containers
container internal length
container internal width
container internal height
container type, closed [0], open [1], rack
[3]

integer
integer
integer
integer
integer

integer > 0
integer > 0
integer > 0
integer > 0
[0, default], [1],
[3]

g bottom top

preferred loading order, rear-front [0],
bottom-top [1], layer-front [2]

integer

[0, default], [1],
[2]

g max overhang

default max overhang percentage of a box
when stacked on another

integer

[0-49], [8, default]

g maxLoad

container max load; null or a negative
value excludes the constraint

float

decimale ≥ 0,
[0, default]

g enforce dens

flag to check the longitudinal weight distribution, yes [1], mean [3], no [default]

integer

[0, default], [1],
[3]

g enforce cm

check of center of mass enabled, yes [1],
forbid shift [3], no [default]

integer

[0, default], [1],
[3]

g
g
g
g
g

total
length
width
height
type
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key

description

type

value

g c of mLowL

lower percentage limit for the center of
mass along g length axis

integer

[0-100],
[0, default]

g c of mHigL

upper percentage limit for the center of
mass along g length axis

integer

[0-100],
[100, default]

g c of mLowW

lower percentage limit for the center of
mass along g width axis

integer

[0-100],
[0, default]

g c of mHigW

upper percentage limit for the center of
mass along g width axis

integer

[0-100], [100,
default]

g tareWg

[dynload only]

float

g pdepth

[dynload only]

integer

g hrack

[dynload only]

integer

g lthick

[dynload only]

integer

g wthick

[dynload only]

integer

g length over length

[dynload only]

integer

g width over length

[dynload only]

integer

g height as load

[dynload only]

integer

g plflag

[dynload only]

integer

g uml
g ump
g status
g prof wgh1
( ,2,3,4)

UNUSED
UNUSED
UNUSED
load of first section (to follow the second,

integer
integer
integer
float

decimal ≥ 0

g prof len1
( ,2,3,4)

length of first section (to follow the 2nd,

integer

integer ≥ 0

third and fourth section of five possible)
3rd and 4th section of five possible)

The fields g prof * are used to define the profile of a non-uniform load. The example
above shows the case where the load 10000 kg needs to be divided on a platform of
length 1200 cm cm in three sections. The values of the last section are calculated by
subtraction.

g maxLoad =10.000

g length

=1.200

g prof wgh1=4.000

g prof len1 =300

g prof wgh2=2.000

g prof len2 =600
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Table pv obs
The table is used to enter the unusable volumes of a container.
key

ID

description

type

integer primary key

integer not

value

integer

null

g cntID

container index (reference to the key pv cnt.ID)

g job

unique identifier of the input list (reference to the

integer not

key pv job.ID)

null

length “low” coordinate
width “low” coordinate
height “low” coordinate
length side
width side
height side
UNUSED
UNUSED

integer
integer
integer
integer
integer
integer
integer
float

integer not

integer

null

g
g
g
g
g
g
g
g

vert L
vert W
vert H
length
width
height
oflag
wgh

integer
integer
integer
integer
integer
integer
integer

Example

g
g
g
g
g
g

field

value

vert L
vert W
vert H
length
width
height

0
0
0
384
249
35

Table pv stack
The stack matrix sets “exceptions” to the “natural stacking rules”. Each row defines
a rule that allows a stacking otherwise forbidden, or forbids a stacking otherwise
allowed.
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key

g job

description

unique identifier of the input list (reference to the

type

value

integer not null integer

key pv job.ID)

g btmID

ID of bottom package (reference to the key pv sku.ID) integer not null integer ≥ 0
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key

description

type

value

g topID

ID of top package (reference to the key pv sku.ID)

integer not null integer ≥ 0

g btmPs

position of bottom package

integer not null [1-63], [63,
default]

g topPs

position of bottom package

integer not null [1-63], [63,
default]

g status

control flag, optional

integer

integer

Example
Records of table pv sku
ID

g code g ps

g nt

1

AAA 3

0

(no rules)

2

BBB

0

(no rules)

3

CCC 63

63

(nothing on top of CCC)

..

..

..

..

3

..

comment

Records of pv stack
g btmID g topID g btmPs g topPs

comment

1

2

63

63

object BBB cannot be placed
on top of AAA

3

1

63

63

object AAA can be placed on
top of CCC

1

1

1

2

object AAA can be placed over
itself only if turned

..

..

..

..

..

g status is an optional field to control the required rule
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g status > 0

means that the stacking must be allowed. The program checks
the natural rule and allows the stacking if it’s “naturally forbidden”, does nothing otherwise.

g status < 0

means that the stacking must be forbidden. The program
checks the natural rule and forbids the stacking if it’s “naturally
allowed”, does nothing otherwise.

g status = 0
or null

is the default choice, and lets the program enforcing the applicable rule.

Table pv exec

The table is employed to assign the execution parameters. Its use in the desktop
version is optional, as all parameters can be set from the User interface.
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key

g job

description

type

value

unique identifier of the input list

integer not

(reference to the key pv job.ID)

null

g max exec time ms

max execution time in milliseconds

integer

integer ≥ 0 [9000,
default]

g time resolution

precision of the control over execution time, [0] normal, [2] accurate

integer

[0, default], [2]

g cost function

cost function, [0] by volume, [1] by
weight.
stop execution policy, [0] stop execution, [1] improve, [2] continue.

integer

[0, default], [1]

integer

[0, default], [1],
[2]

g solv method

solver method: seq-f, seq-a, fst-f, fsta, [plt-r, plt-e, plt-s, mbin]

char(12)

[’seq-f’, default]

g solv smar

parameter needed by the plt-s solver
method.
priority constraint, [0] no, [1] ds as
priority, [2] min as priority.

integer

[7090, default]

integer

[0, default], [1],
[2]

g named filo

assigns the destination index ds based
on the descriptive string of the field
pv sk.g ds: [0] no, [1] yes.

integer

[0, default], [1]

g filo order

FI/LO constraint, [0] no, [1] order
in each container, [2] absolute order
between consecutive containers, [3]
absolute order without order inside
container.
max mixing constraint, [0] no, [1]
yes.
max mixing threshold, integer ≥ 0 or
-1 if not defined.

integer

[1, default], [0],
[2], [3]

integer

[0], [1, default]

integer

integer
[-1, default]

g max bdepth

max depth, integer ≥ 0 or -1 if not
applies.

integer

integer
[-1, default]

g block loadable

check loading / unloading, [0] no, [1]
yes.
rear balance check, [0] no, [1] yes.

integer

[0, default], [1]

integer

[0, default], [1]

g assign job

writing of g userID e g status in table
pv job: [0] no, [1] yes.

integer

[0], [1, default]

g disable rule

allows you to disable certain constraints even if they are defined.

integer

integer ≥ 0

g on optimality

g priority list

g with dsmixing
g max dsmixing

g back equil

integer
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key

description

type

value

g plane tolerance

UNUSED

varchar(255)

g crossing par

UNUSED

varchar(255)

g back face perc

face contact percentage. The values
is applied in case g back equil is active.
Assigns the seed of the random generator.

integer

integer ≥ 0 [30,
default]

integer

integer ≥ 0

g check seed

To assign the execution parameters the application selects the record with g job =
pv job.ID. If the record is not found, the application selects the record with g job =
-1, which can be thought of as the default record. If this is not found, the application
eventually assigns the default values.

g max exec time ms In command line versions, when g max exec time ms = 0 the
application estimates the minimum number of containers needed to hold the load
list. The result is not optimized and must be considered as an upper bound. The
desktop version rounds the value to the closest non-zero time expressed in seconds,
hence the minimum sensible value is g max exec time ms = 1000.
g time resolution is used by the command line versions only.
g solv method defines the type of optimization.

seq-f

sequential with fixed number of containers

seq-a

sequential with calculation of the number of containers

fst-f

fast optimization with fixed number containers

fst-a

fast optimization with calculation of the number of containers

plt-r

mono article,ı̀ with reuse of formed pallets (DYNLOAD only)

plt-e

mono article,ı̀ without reuse of formed pallets (DYNLOAD only)

plt-s

threshold pairing article method (DYNLOAD only)

mbin

sized multibin method (DYNLOAD only)

For the methods seq-a and fst-a the application adds the last item in the container list.

g check seed is a test option and it is recommended that you do not set it or leave
it equal to zero.
g disable rule is a test option and normally should be set null or zero. The numeric
value is the sum of the following values:
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1 - disables bearing checks

2 - disables destinations

4 - disables priority rules

8 - disables stacking checks

16 - disables set / batch load

64 - disables bearing weight

128 - disables container max load

256 - disables “matching code”

512 - disables “load by object”

Table pv report
The table is used by the command line versions to assign the parameters of the
report. The table is not used by the desktop versions.
key

g job

description

type

unique identifier of the input list (reference to

integer not

the key pv job.ID)

null

value

integer

g img layout image layout. The value 0 or null prevents
creation of the images. See section.
g img style style of the images, applies if g img layout ̸=
0. See section.
g img width image width in pixels (≤ 1200)

integer

[0, default]

integer

[3, default]

integer

[600, default]

g img height image height in pixels (≤ 900)

integer

[450, default]

g img type

image format. Supported: bmp, png, jpg, tif,
gif, svg
Excel file format, xls o xlsx. Blank or null
field prevents the creation of the file.

char(3)

[png, default]

char(4)

xls, xlsx [”, default]

g pdf layout layout of pdf file. The value 0 or null prevents
the creation of the file. See section.
g pdf style
style of the pdf report, applies if g pdf layout
̸= 0. See section.
g n views
number of views, or steps in case of stepped
layouts.
g block size size of blocks of identical packages : [0] small,
[1] medium, [2] large.

integer

[0, default]

integer

[0, default]

integer

[4, default]

integer

[0, default], [1],
[2]

g htm layout reports in html format. The value 0 or null
prevents creation of the files. See section.
g um units metric unit for formatting of reports.

integer

[0, default]

g xls report

varchar(64) [”, default]

The record with g job = -1 as the default record as seen for the pv exec table.
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g img layout controls the production of images. The value is obtained by summing
up the following flags, that we organize in sections and to which we give a descriptive
name for clarity
view section

1 FRONT RIGHT - view from frontright

2 FRONT LEFT - view from front-left

4 BACK LEFT - view from back-left

8 BACK RIGHT - view from backright

16 PLANAR - planar view
step section

128 FORCE RESUME - full container
view

256 STEP BLOCK - step images by
blocks

512 STEP LEVEL - step images by
levels

1024 STEP LAYER - step images by
layers

resume section

4096 FULL PLAN - full load plan view
If g img layout is zero or null the program doesn’t create images. Otherwise, the program
first checks for the presence of FULL PLAN and, if the flag is found, produces an image of the complete load plan. Then the program prepares for production of images
of each container entering the solution, checking for the presence of one of the flags
STEP BLOCK, STEP LEVEL or STEP LAYER. For each flag the program prepares a
step-by-step sequence describing the loading of the container. If the flags are not found
the program creates a single summary image. The actual production of the images
depends on the remaining “view” flags, that can be combined. For each “view” the
program creates an image. If the “view” flags are absent, the program applies the
FRONT RIGHT flag as default. The flag FORCE RESUME allows adding of the summary image at the end of the step sequences.

g img style controls the style of images. The value is obtained by summing up the
following values

1 - display text

2 - display color

4 - label on single box

8 - color by destination

16 - length sign

32 - front sign

64 - no label on top face
g pdf layout defines the type of pdf report. The possible values are
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1 single view layout

2 duo view layout

3 quad view layout

4 planar layout

5 simple layout

6 level layout

7 layer layout
g pdf style controls the production of pdf report. The value is obtained by summing
up the following flags

1 - simple view by sections

2 - print loading instructions

4 - print summary list

8 - unique code

16 - one file for container

32 - load plan on new page

64 - without input quantity

128 - no package color

256 - no package label

512 - single box label

1024 - label on loaded boxes

2048 - without manifest header

4096 - without page header

8192 - without page footer

16384 - without logo image

32768 - logo image on all pages

65536 - enforce bottom-top sequence

131072 - enforce rear-front sequence

262144 - print “number of objects”

524288 - use FI/LO colors

1048576 - print FI/LO list
g htm style controls the production of reports in html format. The value is obtained
by summing up the following flags

1 - create the resume report

2 - create the distribution report

4 - create the webGL report
g um units sets the metric units. The default represents cm. Set g um units=1 if
you need mm.
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Table pv bin
The table lists the actual containers used in the solution.
key

ID
g job

g cntID

description

type

value

integer primary key (assigned by the program with
numbering starting from 1)

integer not

integer

unique identifier of the input list (reference to
the key pv job.ID or assigned programmatically if
pv job.ID is not coherent)

integer not

container identifier(reference to the key pv cnt.ID

integer

integer

float
long text

decimal

null

integer

null

or to pv desk cnt.ID in case g job is assigned by the
application)

g vol pc
g sersol

container loading percentage
UNUSED

Table pv geom
The table gives information about the distribution of the packages among the various
containers and the positions of the items.
key

ID

description

integer primary key (assigned by the application)

type

integer not

value

integer

null

g job

g skuID

unique identifier of the input list (reference to

integer not

integer

the key pv job.ID or assigned programmatically if
pv job.ID is not coherent)

null

package identifier (reference to the key pv sku.ID

integer

integer

integer

[1, 2, 4, 8,
16, 32]

integer

integer

integer
integer
integer
integer
integer
integer
integer

integer
integer
integer
integer
integer
integer

or to pv desk sku.ID in case g job is assigned by the
application)

g posID
g binID
g
g
g
g
g
g
g

vert L
vert W
vert H
edge L
edge W
edge H
status

position of the item according the the application

encoding
container index (reference to the key pv bin.ID)
length “low” coordinate
width “low” coordinate
height “low” coordinate
length side
height side
width side
UNUSED

The following picture shows how input and output tables are related
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Tables pv desk
The special tables pv desk sku, pv desk cnt and pv desk to job are used by the desktop version only and allow exports of data when pv sku or pv cnt are empty or not
coherent. This situation occurs, e.g., when the list is defined by some other means
(Excel, using the internal database, open files, direct input, etc.), or User modifies
the imported list. In such cases, on export the application generates a fictitious
negative g job and uses this value to populate the output tables pv bin and pv geom.
At same time, the program populates pv desk sku and pv desk cnt tables assigning to
each record a progressive negative ID. The two tables contain the minimum number
of fields needed for the description of the input list.
In case of modification of the imported list, the table pv desk to job keeps track
of the association between the generated negative g job and the original pv job.ID
identifier. The application uses the pv desk xxx version in case of modified input
only and maintains the original pv xxx.ID value for all unmodified records.

Table pv desk cnt
chiave

descrizione

tipo

valore

ID
g job
g name
g length
g width

integer primary key
unique identifier of the input list
container name

integer not null
integer not null
varchar(64)

integer
integer
text

container length
container width

integer
integer

integer
integer

packVol 3.7.0 - User Guide - 113

chiave

g height
g maxLoad

descrizione

container height
max load (≤ 0 when not defined)

tipo

valore

integer
float

integer
decimal

Table pv desk sku
key

description

type

value

ID

integer primary key

integer not null integer

g job

unique identifier of the input list

integer not null integer

g code

alphanumeric code

varchar(64)

text

g
g
g
g

package
package
package
package

integer
integer
integer
float

integer
integer
integer
decimal

type

value

length
width
height
weight

length
width
height
weight

Table pv desk to job
key

g desk
g job

description

the generated fictitious g job
the original pv job.ID of the imported list

integer
integer

integer < 0
integer > 0
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Preferences
The Preference dialog is activated with the menu command Tools → Preferences
.
It is composed by five windows, accessible by clicking on the list on the left. Each
window displays various groups of parameters logically linked among themselves.

Metric Units
Here you may define the Metric Units used by the program and set the accuracy of
your data. Possible values are
–
–
–
–

Length: mm, cm, m, mil, in, f t;
Surface: mm2 , cm2 , m2 , sq.in, sq.f t;
Volume: mm3 , cm3 , m3 , cu.in, cu.f t;
Mass: kg, lbs, t, ton.

If you do not fix a convention, the program employs the default values cm(1x), m2 ,
m3 , kg .

To enforce data accuracy the program requires integer-valued input without decimal
digits, whereas it allows for a more conventional formatting of the various reports
via the scale factor. An example should clarify the matter.
Suppose that the sides of a package are 12.7cm, 14cm and 23.2cm. Even though
employed units are centimeters, accuracy is actually millimeters and input must be
127, 140 and 232. Output depends on the settings.

User data
12.7 cm
14 cm
23.4 cm

input
127
140
234

1x

10x

output
127 mm
140 mm
234 mm

output
12.7 cm
14.0 cm
23.4 cm

1000x

output
0.127 m
0.140 m
0.234 m

This scheme forces User to drop the decimal dot and it clearly stresses that the
program never rounds the input, which is left “as is”. The same scheme is employed
for Imperial Units.
A change in the metric convention does not lead to conversion of the input data. The
choice of units must be understood as a way to maintain the printing of values, especially
those of volumes, within limits of acceptable size.

This window can be opened directly with the menu command Setting → Metric
Units.

Options
The window allows you to set and save the default values for the Options menu
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entries permanently. These values, shown in table, can be modified at any time, but
all changes made in the Options menu are kept only for the current session.
option

Set the preferred stage color

menu

Options → Black Stage
Options → Info Under Mouse

Enable item highlight when mouse is
over a box

Options → Enable Item Highlight

Check “English pdf Load Plan” option
at program start-up

Applies only to localized versions

Use simplified view by grouped blocks

View → View by Grouped Blocks

Other options allow you to manage warnings displayed by the program.
Prompt for confirmation before deleting a solution
Enables all warnings that allow you to cancel an action leading to deletion of the
solution.
Restore dialog to manage start solver / change of solution
Restores the dialogs with which you can choose a) the solver method when not set,
b) whether to activate the tool Start from Current.
Restore all information message boxes
A message can be hidden by activating the optione “Don’t show this dialog again.”.
This option restores all messages.
Restore default grid size settings
Allows you to restore the size of the panels on the left, and the size of the grid cells,
to their default values.

Solver
The panel displays the default that the program uses in case of opening a new document, or in case of import of data. If you select the option show current values
the panel displays the current settings. To save the shown settings, check the option
save these as default and press Apply.

Container
You can define a particular container as default, forcing the program to automatically load its data when opening a new document. This feature may be useful if
you work most of the time with the same container. To define the default container,
simply choose the container from the list and press the button Set as Default. The
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button Reset deletes the association.
Two text boxes allow you to set the default values for max overhang and for the
loading order.

Import
The options inside the panel allow you to assign some preferences for the import
procedures.
opzione

Use “named” destination on
import (ordered by first entry)

If active, the Excel cell value containing the
destination, or the ODBC table field, is considered alphanumeric. The numerical value of the
parameter ds is assigned progressively based on
the first occurrence of the string. If inactive,
the value is assumed numeric and assigned directly.

Use custom Excel format

This function is described in separate documentation.

Don’t show row preview on
Excel (ODBC) import

The option allows to skip the preview dialog
shown before importing data.

Always make a backup copy of
the internal database

Before altering the internal database the program
makes a backup copy with name packVol.sqlx.bak.

Advanced
Default positions. To avoid too much typing, when entering new items manually,
the program automatically sets all positions as allowed and assigns the value 63 to
the corresponding cell ps of the Constraint P tab. You may change the default value
by selecting the appropriate entry in the drop-down menu. In case of other, the
value must be typed manually using a numerical code.
Manual Solver options. In manual mode the program tries, whenever possible,
to place a package in a valid position fulfilling all imposed constraints. The three
options

– at lowest possible level (layer packing);
– on top of rear columns (wall packing);
– as determined by the program itself;
suggest to the program how the insertion points should be searched and tested.
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Report
The first option, Modify current Automatic Pdf Export settings opens the pdf Export dialog in preference mode. All values are saved and used as default. The other
options are described in the Fixed Preferences section.
Change Logo Image

Allows you choose the logo image to include in the
report.

Header Captions

Allows you to change the caption of the two header
lines and the date format.

qt/b and qt/b tot

If load by objects is enabled, you may choose
whether to display in the list the number of objects
and the total number of loaded objects .

Don’t show Input Qty on
Packing Lists

If selected, the input quantities are not included in
the report.

Show Code Labels on all
listed packages

Displays the code on the all groups of packages.

Define names of positions

Allows you to assign a name to the position ps. The
names are included in the loading instructions.

Set captions and labels for
English reports

Applies only to localized versions.
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Appendix

Encoding of positions
The parameter ps which describes the allowed positions is encoded with a single
integer obtained by summing up the values in the following table for each allowed
position. The parameters fl, tp and nf are encoded in a similar manner.
value

description

1

length, width, and height are aligned with length, width, and height of
the container.

2

rotation about the vertical axis of position 1
(exchange length ↔ width).

8

the initial position 1 is “lying down” on the width side
(exchange width ↔ height).

4

rotation about the vertical axis of position 8
(exchange width ↔ height, then width ↔ length).

32

the initial position 1 is “lying down” on the length side
(exchange length ↔ height).

16

rotation about the vertical axis of position 32
(exchange length ↔ height, then width ↔ length).

1

8

32

2

4

16

Knowledge of the position code is needed for all operations related to the automatic
import of data. A special dialog of the Preferences window allows you assign a label to
each position.

packVol 3.7.0 - User Guide - 119

Some examples
When all positions are allowed you set ps = 63 (1+2+4+8+16+32).
For a pallet, which should never be lying on its sides, you require ps = 3 (1+2).
For a freezer, that you want to just lay on a given side, you must force ps = 12
(8+4) or ps = 48 (16+32) 32), according to the definition of the edges.

Coordinates
The origin of the coordinates is located at the rear of the container.
“low” and “high” coordinates are
depicted in figure.
Order of the triplet is (W,L,H).

Load by objects
The “load by objects” is a form of implicit
pallet loading. The feature is activated by
checking the specific check box in the Configure
Database dialog. When using it, the Box grid
carries the extra column qt/b, that lists the
number of objects which make up the package.
In fact, the program allows to fill each package
with objects of unspecified form, up to an amount which corresponds to the value qt/b, and to force the input of packages by
number of objects. The field qt/b is also present in the Package Managers, together
with the additional field type, with its two possible values box (label which indicates
packages with a fixed height) and plt (label which indicates packages with a variable
height). For plt types you can define the height of the base hb. For this purpose,
– in the Package Manager in the maintenance mode you use the text field
hb;
– when importing from Excel you use the column AD. If the value is zero,
the packet is considered to be of type box, otherwise the value is associated with the height of the base and the package is considered to be of
type plt;
– when importing from Excel you use the field g btype. The same scheme
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of the previous point applies.
When transferring data from the database to the Package Panel, data for which qt/b
̸= 1 are not inserted directly into the grids, but are transferred to a further dialog,
in which you have to enter the number of objects that you need to load. At this
point, the diﬀerence between the type box and plt takes place. The corresponding
number of packages is evaluated according to the following rules:
– box: the program defines the minimum number of packages such that all objects
can be stored, by assuming that every box can contain qt/b objects at most,
keeping the linear dimensions of the package fixed. For example, if qt/b=20,
wt.=7.1 and you enter number=110 in the dialog, then in the Dimen. grid will
be defined two distinct items for a total of 6 packages, 5 packages with wt.=7.1,
and 1 package with wt.= 3.5, all having the same dimensions;
– plt: the program defines the minimum number of packages such that all objects
can be stored, by assuming that every box with height h can contain qt/b objects
at most, and varying the height h proportionally to the number of objects. The
proportion is performed by subtracting from the height h the value of the height
of the base hb, which is then added to each resulting package. For example,
if qt/b=500, wt.= 283.0, z=132, hb=12 and one enters number=1800, then
two distinct items will be defined in the Dimen. grid, for a total of 4 packages,
3 packages with wt.=283.0 and h=132, and 1 package with wt.=169.8 and
h=84.

Define the load sequence
The two mutually exclusive options Rear-Front and Bottom-Top are found in Current
container tab, in the View menu, and in the Pdf Exporter preference dialog. They
all share the same name, related to sequence order, but play a quite diﬀerent role.

In Current Container
The option instructs the automatic solver on how to stow the packages and it is
assumed as a property of the container (for example, the choice is stored in the
database whenever the container is saved). The diﬀerent behavior of the solver is
easily seen in case of a partially filled container, as shown in the two figures below.

In manual mode the option may be employed by the program as a hint about where
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to place the next box which is going to be packed if the setting as predetermined by
the program itself in the Solver tab of the Preferences dialog is activated.

In View Menu
The option in the View menu defines how the sequence should be visualized when
acting with the slider. The two figures show an example of diﬀerent sequences for
the same load, which as been optimized as Bottom-Top, according to the choice
Bottom-Top and Rear-Front

The third option Container Default Sequence sets the value equal to the parameter
chosen in the Current Container tab.
The option Rear-Front Sequence or Bottom-Top Sequence is taken into account when
creating the load plan for a single container. Please check its value before starting the
Create Load Plan session. The options get disabled when the optimization is performed
in manual mode and the the check-box reorder box sequence at end of work session
in the Preference dialog (Advanced tab) is unchecked. In this case the program does
not perform any ordering, leaving the sequence exactly as defined by the User during the
manual session.

In Automatic pdf Export
The option in the Pdf Export dialog defines the visualization order of the packages in
the pdf report. The choice applies to all containers entering the load plan document.

Rack Container
If the edge size exceeds the rack width the program places the packages on the floor
in central positions (“symmetric overflow”). In the case the edge size is less than
rack width, the overflow on one side (“asymmetric overflow”) is permitted and is
controlled by the value of Max box overhang (%), which in turn can be set at the
level of the container, or for each individual package.
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For the rack-container the tool
becomes active and allows
you opening of the dialog of the
“Optional Container Data”, where
you can set the value of some
constraints. The relevant parameters for the optimization are

External Dimensions
Height [H] options

description

Fixed Parameter

The height is the same as defined in the Current tab.

Load Extension

Placement of a package is always accepted, provided
that the base lies within the physical height of rack

Width [W] options

Fixed Parameter

The width is the same as defined in the Current tab

Load Extension

The “symmetrical overflow” is accepted whatever the
size of the package

Length [L] options

Fixed Parameter

The length is the same as defined in the Current tab

Rack options
command

description

Min Vertical Overlap (%) The parameter imposes (as percentage) the minimum
contact between the package and the physical height of
the rack (see figure on left) and allows a more precise
control of the vertical order.
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command

Allow “inverse stair”

description

no - the “overflow” is permitted only for packages on
the floor
yes - the overflow is permitted in any case (see figure at
right), within the limits imposed by Max box overhang
(%)

Commonly used values are Height [H]=Fixed Parameter, Width [W]=Load Extension, Allow “inverse stair”=No.
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Information and License
Please contact us at www.packvol.com for any question about registration, integration with other applications, or for updates.

License
PACKVOL END USER LICENSE AGREEMENT (‘‘EULA’’)
THIS END USER LICENSE AGREEMENT (‘‘EULA’’) IS A LEGAL DOCUMENT. IT PROVIDES A
LICENSE TO USE THE SOFTWARE AND CONTAINS WARRANTY INFORMATION AND LIABILITY DISCLAIMERS. BY USING THE SOFTWARE, YOU AGREEING TO BECOME BOUND BY THE TERMS OF
THIS AGREEMENT. READ IT CAREFULLY BEFORE COMPLETING THE REGISTRATION PROCESS.

This End User License Agreement (‘‘EULA’’) is a legal agreement between you, the
licensee under this Agreement (either an individual or a single entity), and packVol.com
di Angelucci Dr. Antimo, an Italian sole proprietorship with its place of business at Via Giulia 1, I30026 Portogruaro (VE), Italy, herein referred to as ‘‘AUTHOR’’,
with regard to the computer software known as packVol herein referred to as ‘‘SOFTWARE’’,
provided with this EULA.
1. TITLE. Title to SOFTWARE and all associated intellectual property rights is
retained by the AUTHOR. This license gives you no rights to such content.
2. LICENSE GRANT. The AUTHOR grants you a non-exclusive and non-transferable
license to install and use the SOFTWARE provided with this EULA.
a) A unregistered copy of the SOFTWARE (‘‘UNREGISTERED SOFTWARE’’) may be used
by you for EVALUATION PURPOSES ONLY for a period of thirty (30) days following
the initial installation (‘‘TRIAL PERIOD’’). The UNREGISTERED SOFTWARE may be
freely copied and distributed to other users for their evaluation. At the end
of the TRIAL PERIOD, you must either purchase license(s) to register the SOFTWARE
or remove it from your system.
b) You may install the registered SOFTWARE on any computer owned by you, provided
that the number of concurrent users does not exceed the number of licenses purchased.
This EULA does not apply to site-wide license, in which case additional or different terms shall apply.
c) You may make a reasonable number of backup copies of the SOFTWARE, provided
backup copies are not installed or used for other than archival purposes.
d) The purchase entitles you to obtain free upgrades for all the upcoming 3.x.x
releases of the SOFTWARE and/or for all the versions released within one year
from the purchase.
3. RESTRICTED USE. Unless enforcement is prohibited by applicable law, you may
not:
a) remove or obscure logo, copyright, AUTHORS’s proprietary rights notices or
any other notice in or on the SOFTWARE and in or on its associated files.
b) alter, decompile, disassemble or reverse engineer the SOFTWARE or create derivative works from the SOFTWARE.
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c) adapt, rent, lease, loan, resell, or distribute any product derived from the
SOFTWARE or related files including, without limitation, the database support.
d) disclose to any third party any activation key, which is strictly confidential and personal to you.
e) transfer or assign to third parties your rights under this Agreement without the prior written permission from AUTHOR.
The AUTHOR reserves the right to enforce the terms of this EULA which may at the
AUTHOR’s discretion comprise actions such as license key validation and concurrent access monitoring.
4. DISCLAIMER OF WARRANTY. The SOFTWARE is not intended to be a substitute for
professional judgment and the entire risk as to the quality and performance of
the SOFTWARE is with you. The SOFTWARE is not intended for use in the design
or operation of nuclear facilities, life support systems, aircraft or other activities in which the failure of the SOFTWARE could lead to death, personal injury,
or severe physical or environmental damage. THE SOFTWARE IS PROVIDED ‘‘AS IS’’
WITHOUT WARRANTY OF ANY KIND. TO THE EXTENT PERMITTED BY LAW, THE AUTHOR AND SOFTWARE’S
DISTRIBUTORS HEREBY DISCLAIM ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE OR NON-INFRINGEMENT. YOU BEAR ENTIRE RISK AS TO SELECTING
THE PRODUCT FOR YOUR PURPOSES AND AS TO THE QUALITY AND PERFORMANCE OF THE PRODUCT.
THIS LIMITATION SHALL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF
ANY REMEDY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES, SO THIS DISCLAIMER MAY NOT APPLY TO YOU.
5. LIMITATION OF LIABILITY. EXCEPT AS REQUIRED BY LAW, THE AUTHOR AND ITS SOFTWARE’S
DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. SOME COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.
6. INDEMNIFICATION. If you use or distribute the SOFTWARE in violation of this
Agreement, you agree to indemnify, hold harmless and defend THE AUTHOR and its
SOFTWARE’S distributors from and against any claims or lawsuits, including attorney’s fees that arise or result from the use or distribution of the SOFTWARE
in violation of this Agreement.
7. TERMINATION. If you breach any of the terms or conditions of this Agreement your right to use the SOFTWARE will terminate immediately and without notice,
but all provisions of this Agreement except the LICENSE GRANT (clause 1) will
survive termination and continue in effect. Upon termination, you must destroy
all copies of the SOFTWARE and any record of the activation key.

